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56 Ask Us
We explain FireWire-free video chat, rediscover 
some old-school gaming goodness, and show 
you how not to use Apple’s Mail.

58 Hack Your Toys
Don’t send that unloved action 
fi gure or rubber rat to the Island 
of Misfi t Toys. Turn it into 
freakish Mac hardware instead. 
by Niko Coucouvanis

60 Tap Into Your Home 
Network Remotely
Remote Mac access can be 
a pain to set up—here’s 
how to do it correctly. 
by Niko Coucouvanis

features

28 iTunes Master Class 

iTunes is easy to use, but a lot of power hides beneath its brushed-
aluminum hood—learn some new tricks at iTunes University. 
by Brad Miser

34 Image Is Everything
A little fuzzy on what Gaussian Blur is or what Unsharp Mask does? This 
guide to image-editing lingo will help you master your digital darkroom. 
by Johnathon Williams

19  52  Must-Have Apps 
(That Won’t Break Your Bank)
Good software doesn’t have to be expensive. Meet the bargain apps 
we voted Most Deserving of a Place in Your Dock. by Jake Widman

how to
62 Dig Into Quartz Composer
Become a Mac OS X developer by crafting 
your own RSS-enabled screen saver. It’s 
easier than you might think. 
by Erick Tejkowski

64 Get Videos 
onto Your iPod
Not satisfi ed with the 
video selection in the 
iTunes Music Store? 
Here’s how to get your 
own movies to go. 
by Niko Coucouvanis
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 TRICKSY MAIL
If you want to make an email 
app other than Apple’s Mail 
your default reader, change a 
preference within Mail fi rst. 
From Ask Us, p56.

 WALKMAN BLUES
If your new W800i Walkman 
phone causes your Mac to 
freeze, try the donationware 
app K750iGrabber. Use 
FinderCleaner if music fi les 
won’t play. 
From 
Reviews, 
p42.

 NO NEED TO GO PRO
If you have iLife ’05 and 
regular QuickTime, you don’t 
need to buy QuickTime Pro to 
convert videos for your iPod. 
From “Get Videos onto 
Your iPod,” p64.

 BRAIIINNNNS!
If you have an army of the 
undead at your command, 
send it headfi rst into a gang of 
gun-toting humans while you 
eat their brains from the side. 
From Get Info, p12.
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good to say, “I told you so!” (“Neener, neener!” optional.)
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Take a quick gander at the looong list 
below—it’s packed with 107 apps, demos, 
trials, and more. Enhance your creativity. 
Work more productively. Have some fun. 
This month’s Disc has you covered.
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the disc

UPGRADE
If you don’t receive the Disc with your copy of MacAddict, you might want to consider upgrading. Each monthly Disc contains cool 
demos, useful shareware and freeware, and the inimitable MacAddict Staff Video. To get 12 issues of MacAddict that include this value-
packed disc with your subscription (prorated if necessary) for just $1 more per issue, call 888-771-6222—the operator will take care of 
everything.
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AUDIO & MUSIC
Album Cover Finder 3.3.5 trial
Apple Loops 1.0 freeware
AudioFinder 3.9.1 donationware
AudioFinder 3.3.9 donationware
Guitar Rig 2.0.0.005 demo
iSweep 1.3 shareware
iTunes Dupes Barrier 1.1.2 
 shareware
Mac Audio Toolbox (OS X) 1.8
 shareware
Peak LE 5 trial
SoundSource 1.0.5 freeware
WireTap Pro 1.1.3 shareware

DEVELOPMENT
REALbasic 2005 R4 demo

FUN & GAMES
Arithmetris (Classic) 1.0
 shareware
Arithmetris (OS X) 1.0 shareware
Big Kahuna Reef 1.0 demo
Bloxter 1.2.2 trial 
BusyBee 3.5 freeware
ComicBookViewer 0.7 beta
Gambit 1.0 shareware
GeoParty 1.0.1 freeware
Germs 1.0 shareware
iDice 3D 1.1 shareware
Magic Dice 1.0.1 demo
Petal Palace 1.0.1 shareware
Poker Academy Pro 2.0 demo
Ricochet Lost Worlds 1.0 demo

GRAPHICS & MULTIMEDIA
ArtRage 1.1 freeware
Comic Life 1.2.2 trial
DeBabelizer Pro 6.0 trial
DeBabelizer Pro Server 6.0 trial
EasyCrop 1.9 shareware
EasyFrame 1.2 shareware
iDive 1.4.5 shareware
Image Tricks 1.1 freeware
JAlbum 4.6 freeware
Photo Drop 1.0 donationware
Picture Arena 1.3.5 trial
X-ray 1.0 demo

INTERFACE
A Better Finder Rename 7.0 trial
Default Folder X 2.0.4 demo
Default Folder X 1.8 demo 
FinderCleaner 1.6 freeware
MyControls 1.0.0 shareware
WindowShade X 4.0.2 shareware

INTERNET & COMMUNICATION
1-Click Answers 1.0 freeware
1-Click Answers 1.0 widget
Advanced Link Manager 1.1 trial
Chat Transcript Manager 1.0
 freeware
Cyberduck 2.5.2 freeware
FileChute 1.9.2 shareware
GarageSale 1.9.4 shareware
iChatUSBCam 2.0.6 trial
IOXWebcam X 1.1 trial
iTuneMyWalkman 0.8 
 beta freeware
Little Snitch 1.2.1 shareware
MailSteward 3.8.2 demo
PC-Mac-Net FileShare X Lite
 5.1.2 freeware
Speed Download 3.0.14 shareware
Watcher’84 1.4 shareware
Yummy FTP 1.1.5 shareware

PRODUCTIVITY
Atomic Mac 6.3.1 shareware
AuctionSieve 1.6 freeware
Budget 4.6.2 shareware
Chirp 2.1.0 trial
Diet Sleuth 4.3.1 shareware
Digital Alarm Clock 2.5 trial
HyperTranscribe 1.0 demo 
iFlash 2.6 trial
iList Studio 3.0 demo
iOrganize 6.1.3 (OS 10.4.x)
 shareware
iOrganize 5.5.5 (OS 10.2.x or 
 10.3.x) shareware
iOrganize 4.4.7 (OS 10.1.x)
 shareware
LargeType 1.0 freeware
Mellel 2.0.1 trial 
NoteBook 2.0 demo
PCalc 3.0.2 shareware

Phonebook 3.7.4 shareware
PocketMac for BlackBerry 3.5
  demo
SessionTimer Pro 4.4 freeware
Shoebox 1.2 shareware
TapDex 1.2.5 freeware
TaskTime3 3.6 trial
Textpander 1.2 freeware
The Omni Group Software 
 Bundle demo
TimeNet Pro 3.2.8 shareware
Tinderbox 3.0 demo
TopXNotes (OS X) 1.0.4 trial
TopXNotes (Classic) 1.0.4 trial
VelaTerra 1.1 demo

UTILITIES
BurnX 1.5 freeware
Data Rescue II 1.0 demo
Defaults Manager 1.0 beta
 shareware
DiskTracker (Classic) 2.3.2
 shareware
DiskTracker (OS X) 2.3.2 shareware
Filegazer 1.1 trial
Font Tools (OS 10.4.x) 4.1 demo
Font Tools (OS 2.x or 10.3.x) 4.1
 demo
FontThing 1.4.5 demo
Google Maps Plugin for Address 
 Book 1.0 donationware
Mac Pilot (OS 10.2.x or 10.3.x) 2.0 
 demo
Mac Pilot (OS 10.4.x) 2.0 demo
macam 0.8.3 beta freeware
MenuCalendarClock for Entourage
 2.1.0 shareware
MenuCalendarClock for iCal 2.1.1
 shareware 
Password Retriever 5.0.7 demo
Preferential Treatment 1.1.5
 freeware
TechRestore Demo Video

SPONSORS
Big Kahuna Reef 1.0 demo
Data Rescue II 1.0 demo
MyControls 1.0.0 shareware
NoteBook 2.0 demo
Peak LE 5 trial
Phonebook 3.7.4 shareware
Poker Academy Pro 2.0 demo
Ricochet Lost Worlds 1.0 demo
TechRestore Demo Video
The Omni Group Software 
 Bundle demo
TopXNotes (OS X) 1.0.4 trial
TopXNotes (Classic) 1.0.4 trial

Comic Life trial
Liven up photos, create 
a comic for your kids, or 
even create 
a MacAddict-
style how-to. 

Peak LE 5 trial
This baby brother to 
BIAS’s Peak Pro offers 
high-quality 
audio-editing 
features.

Staff Video: MouseRider
MacAddict’s How-To Editor, Niko Coucouvanis, 
is no fan of Apple’s Mighty Mouse—except as 
a vehicle and a target of the Pitching Wedge of 
Banishment. Join him on his, um, “rustic” video 
odyssey.

iList Studio 
demo
Databases needn’t be 
diffi cult to build and 
use—and iList 
Studio is proof.



In case you missed it—though I doubt you, 
as a true Mac addict, did—respected analyst 
Charles Wolf of the investment-banking 
and asset-management fi rm of Needham 
& Company announced in mid-November 
that over one million Windows users had 
switched to the Mac in the fi rst three 
quarters of 2005. 

Welcome, guys ’n’ gals!
Apple’s on a roll—and those of us who’ve 

stuck with our Macs through thick, thin, and 
Amelio have good reason to celebrate. I, for 

one, am trying hard not to bellow “I told you so!” to the petty pundits 
who’ve dissed Apple over the years and are now dealing with the 
diffi cult task of eating crow while they have egg on their faces. 

How wrong have they been? Take a quick trip with me to The Mac 
Observer’s Apple Death Knell Counter (www.macobserver.com/
appledeathknell), which chronicles some of the more-ludicrous errors 
of punditorial excess. For example:

• When asked in 1997 what he would do if he were CEO of Apple, 
Michael Dell said, “I’d shut it down and give the money back to the 
shareholders.” In the fi rst three quarters of 2005, Apple’s stock value 
rose over 100 percent; during that same period, Dell Computers’ 
stock sank about 25 percent.

• In 2001, BusinessWeek (www.businessweek.com) published a 
commentary entitled “Sorry, Steve: Here’s Why Apple Stores Won’t 
Work.” At the beginning of 2005, 101 Apple Stores were already 
hosting one million visitors per week.

• A year or so ago, while writing about the iPod and Apple for CBS 
MarketWatch (www.marketwatch.com), John Dvorak predicted 
that “milking this one pricey and faddish device is going to ruin the 
company.” Uh, not quite, John—and I hope MarketWatch-reading 
investors didn’t follow your advice. 

• BusinessWeek again, this time as 2000 drew to a close: “Steve Jobs 
has no white rabbits left in his hat. Apple appears to be facing a dead 
end.” The next year, Apple introduced the iPod—and it was white.

I could go on, but you get the idea. Of course, what goes up must come 
down—but we’ll stick with what was emblazoned on the cover of the fi rst 
MacAddict back in 1996: “The Mac’s Future Is Bright.”

   Enjoy,

Catch the Wave

Next month we’ll take you behind the scenes at Mac Expo, where we’ll dig into Apple’s new stuff and ferret out the best new 
products from other folks. We’ll also let you in on the secrets of Microsoft Offi ce—tips, tricks, and fi xes for Word, Excel, and 
their co-conspirators. Our Field Guide will identify the most-useful AppleScripts and show you how to make them work for 
you. Then we’ll create killer charts in OmniGraffl e; hack OS X’s unhackables with Rezilla, the new-age resource editor; make 
your Mac act like a TiVo; and migrate fi les and system settings to that new iMac that Santa left under your tree. Finally, we’ll 
have in-depth reviews of Apple’s Aperture, a pile of iPod nano cases, Ableton’s Live 5, and Zizzle’s dizzy iZ.

comingsoon:march2006
Here’s what our editors are preparing for the next issue of MacAddict.

 

STAFF RANTS
Q. What should Apple do to become even more successful?

Niko Coucouvanis SLOW MOE
What should Apple do to become even more successful?
That’s easy: Reinvent the wheel. Sure, everybody warns 
against messing with that time-proven round design, but I 
remember hearing similar warnings about computers and their 
beigeness. Come on Apple, wow me with an iWheel!

Sean Molloy CREATIVE SOLUTION SYNERGIZER
What should Apple do to become even more successful?
Simple, really—in addition to Pixar, Steve Jobs just needs to 
become the CEO of EMI, A&M, Sony, Rhino, Dreamworks, 
Arista, Paramount, Doggystyle, Universal, Atlantic, RCA, 
Warner Bros., and every other media company whose content 

he’d like to offer in the iTunes Music Store. Might as well take over the RIAA 
while he’s at it.

Roman Loyola IVE LEAGUE CHEERLEADER
What should Apple do to become even more successful?
Apple needs to do whatever it takes to keep design guru 
Jonathan Ive happy. He’s the reason why the iMac and iPod 
are so hot, and he’ll have important infl uence on future Apple 
hardware. Don’t let that guy go!

Mark Rosenthal SEÑOR EL CHEAPO
What should Apple do to become even more successful?
Apple needs to come out with some cheaper versions of its 
products. Sure, they’ve captured all the consumers who have 
$250 burning a hole in their pockets, but what about the kids 
who want to spend $39.95? 

Jake Widman FREQUENT SHOPPER
What should Apple do to become even more successful?
First, make this whole Intel thing come off without a hitch—that 
way Apple can maintain the momentum it already has. 
Then, fi nd a way to let the Mactel machines do something 
the PowerPC machines can’t—like run a full-blown virtual 

Windows machine—without obsolescing existing Macs. That should do it.

Peter Marshutz ANTI-PUNDIT
What should Apple do to become even more successful?
My advice to Apple is keep on doing what it does best: “Think 
Different.” It’s been working great so far, so don’t change 
course. And also, keep ignoring the Chicken Littles who’ve 
been predicting Apple’s demise. 

Max BIG DREAMER
What should Apple do to become even more successful?
Buy Microsoft—the company, not the stock. Then put 
Longhorn, Vista, or whatever they’re calling it this week out 
of its misery, open up Mac OS X to run on any Intel-based 
hardware, and the long white-knuckled nightmare that has 

been Windows will be over. How much would Microsoft cost? Hey, I’m an 
idea guy—don’t bother me with details.

10 EDITORS’ PAGE
a note from the kernel
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the news of the month in bite-size chunks

12

move as a sign that portable video is 
something consumers want.

While Apple, ABC, and now NBC 
are already petitely partnered in ’Pod 
TV, other major networks are already 
making moves that indicate they may 
not want to board the iTunes Music 
Store express—possibly because 
they’ve heard the complaints of their 
music-business buddies who feel that 
iTMS has a restrictive lock on digital-
music distribution and pricing. Not 
even a month after the video iPod’s 

T
here’s a common belief that 
while Apple isn’t often the first 
to do something, it’s often the 
first to do it right—and while 
you can certainly say that 

about the iPod shuffle, the new media-
centric iMac, and lots of Cupertino’s 
other recent fare, you can’t necessarily 
say it about the new video-capable 
iPod—yet. Sure, it’s an impressive piece 
of technology, but months after its 
release, all we’re able to download from 
the iTunes Music Store are music videos, 
some Pixar shorts, and a smattering 
of TV shows. As of this writing (in early 
December), ABC and Disney still offer 
only five shows (one of which, Night 
Stalker, has already been cancelled); 
and just before MacAddict’s mighty 
presses began to roll, Apple announced 
that it was adding 11 shows from NBC, 
USA, and the SciFi Channel (including 
Law & Order, Monk, and “vintage” fare 
like Knight Rider) to its catalog—but 16 
shows barely scratch the surface of what 
could be playing on your ’Pod. What 
good is a video player if you can’t watch 
anything you want, any time you want? 

While the arrival of the video iPod 
hasn’t yet triggered a portable-video 
revolution, it has caused some ripples 
that could indicate what’s to come. 
Here are some of the more-interesting 
phenomena to crop up in its wake.

TiVoToGo. TiVo raised eyebrows 
in November when it announced that 
it would soon allow users to transfer 
recorded shows onto a video iPod or PSP. 
At first glance, that’s awesome news—but 
it comes with some catches: The service 
(which is actually an extension of an 
existing service called TiVoToGo) will be 
available only to direct TiVo subscribers 
with a Series2 box—no one who gets TiVo 
through DirecTV will be able to use it. 
Also, the current TiVoToGo service only 
works by first transferring TiVo programs 
to a Windows-based PC; the new service 

The video iPod 
hasn’t sparked a 
portable-media 
revolution quite yet 
—or has it?

is expected to work the same way (TiVo 
hasn’t explicitly said it would be a “direct 
to iPod” service). Furthermore, a Mac 
version of the required software won’t be 
ready until “some time next year.”

Battle of the network superlawyers. 
One potential roadblock: The networks, 
who (according to an article in Variety) 
are “none too happy” with TiVo’s 
announcement. Some networks, 
including NBC, responded by threatening 
legal action; other networks, such 
as The WB, are simply taking TiVo’s 
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NEW STUFF

4 SAVE ON THE NETWORK 
 StorCenter
 $199.95 (160GB), $298.95 (250GB)
 www.iomega.com
 Available: Now
 This network-attached hard drive 

uses Gigabit Ethernet to connect to 
your network. Use it to share fi les 
between Macs, or use the included 
Iomega Automatic Backup Pro 
software to back up your fi les.

4 LEAVE IT TO BEAVERS
 Didi & Ditto: First Grade
 $19.99
 www.kutoka.com
 Available: Now
 Kids can help Didi and Ditto bring 

an end to the Wolf King’s rule over 
the Valley by solving math, reading, 
writing, science, and other puzzles 
geared toward fi rst graders.

4 10-MEGAPIXEL SLR
 D200
 $1,699.99
 www.nikondigital.com
 Available: Now
 This impressively speedy digital 

SLR can shoot up to fi ve frames per 
second. It has a 23.6mm-by-15.8mm 
10.2-megapixel CCD, 2.5-inch LCD, 
and 11 areas of focus.

The second in the Didi & Ditto series.

The successor 
to Nikon’s 
D100.

 NEW STUFF            A jazzy lil’ 
       drive with 
  plenty of zip.

release, CBS revealed it was in talks 
with Google to feature its shows in a 
video-on-demand service. Meanwhile, 
nearly every network has dabbled in 
free day-after downloads of some of 
its shows: The WB recently offered 
up Supernatural; UPN handed out 
downloads of Everybody Hates Chris.

GUBA GUBA Hey! If you can’t wait for 
the networks to get their ducks in a row 
and you don’t mind swimming in legally 
murky waters, there are alternatives. 
One of them, GUBA (www.guba.com), 
acts as a gateway to the Usenet, the 
Internet’s unregulated dumping ground 
for fi les of all shapes and sizes. Your 
$14.95-per-month subscription gives 
you access to every newsgroup under 
the sun (including plenty of unsavory 

ones) through an easy-to-use interface 
with handy slide-show thumbnails of 
a video’s content, and play-in-a-Flash-
window previews. The real kicker: 
Most videos have a Download For iPod 
button so you can download the video 
in ’Poddable MP4 format with no muss 
or fuss.

GUBA comes with a giant warning 
sticker, however: The Usenet is rife 
with illegal rips of commercial DVDs, 
fi lm bootlegs, and other copyrighted 
material. Even downloading freely aired, 
unencrypted network-television shows is 
of questionable legality. Some conspiracy 
theorists speculate that Apple is secretly 
rooting for “unoffi cial” channels to fl ood 
iPods with content—more reason for 
networks and studios to hop on the iTMS 
express sooner rather than later.

In the meantime, if you’re looking 
for conscience-friendly iPod fare, Veoh 
(www.veoh.com) recently released a 
catalog of 3,000 public-domain and 

user-produced videos, while Flixpo 
(www.fl ixpo.com) similarly offers a 
gallery of amusing commercials, stand-
up snippets, machinima, and more.

What about What About Bob? Many 
critics agree that the video iPod’s biggest 
weakness is the lack of support for 
ripping commercial DVDs like you can 
rip CDs you’ve purchased—why buy an 
iPod if you can’t put content you already 
own onto it? Movie studios are in no rush 
to make their fi lms available as online 
downloads for portable players.

This has prompted companies such 
as Makayama Interactive to release 
software such as iPod Media Studio 
($32.95, www.makayama.com), which 
purports to break the encryption scheme 
on commercial DVDs you own so that 

you can import them into your iPod. In a 
similar vein, TVMyPod (www.tvmypod
.com) sells new video iPods preloaded 
with DVDs—you get the actual DVDs, 
too. Both of these tread on majorly 
questionable legal ground, since the 
Digital Millennium Copyright Act says 
it is illegal to break any encryption 
scheme, even if you only intend to make 
a backup of your own media (though 
that provision is currently up for review 
by the U.S. Copyright Offi ce)—that’s just 
one reason you probably won’t see DVD-
ripping built into iTunes anytime soon.

There’s no doubt that the arrival of 
the video iPod has dredged up more 
murk, sludge, and FUD than viable 
content—and don’t be surprised if gnarly 
digital-rights questions keep you from 
downloading movies for another year 
or more. But when it comes to portable 
video, Apple may be setting a trend 
instead of refi ning one—whether it 
wanted to or not.—Sean Molloy

With the addition of 11 NBC, USA, and SciFi 
Channel shows makes the iTMS’s video 
selection look (a little) more healthy. 

GUBA is a gateway to all the video on the 
Usenet, whether it’s legally available—or 
morally acceptable—or not.
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’Book  
ArmorB
Axio’s Hardsleeves  
($119.95 to $129.95,  
www.axio-usa.com)  
are tough polycarbonate-plastic cases for 
your PowerBook or iBook. Inside each case 
is an EVA foam compartment so your ’Book 
is comfy, cozy, and uncrunchable. Each 
Hardsleeve also has a guitar-style quick-
release shoulder strap and detachable case 
for your iPod or power adapter.

Building BlocksD
LaCie’s Brick Desktop Hard Drives ($119.99 to $399.99, www.lacie.com) are the brainchild of French designer Ora-Ïto, who clearly 
found inspiration in a famous childhood toy. These USB 2.0 drives are available in 160GB (white), 250GB (red), 300GB (blue), and 
500GB (red)—equally patriotic whether you’re in France or the U.S. of A.
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DROOLWORTHY
Sexy Stuff We Can’t Wait to Get Our Mitts On
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MASTER CHIEF GOES 
TO HOLLYWOOD

GAMELINESS IS NEXT TO GODLINESS
 In Black & White 2, you must choose between ruling your 

followers with kindness or dominating the world through fear—
every move that you (and your animal-god avatar) make affects 
the land and its people. With highly detailed environments 
and weather effects, new technologies and miracles, more 
emphasis on military strategy, and new creature tricks (such 

as fertilizing forests), 
Black & White 2 is 
designed to be easier 
to play and harder to 
stop playing.—MO

Black & White 2
Price TBD

Available Spring 2006
Feral Interactive
www.feralinteractive.com

COMBAT MISSIONS FOR A MODERN ERA
 When a coup eliminates the Syrian government and the United 

Nations calls for removal of the new hostile leaders, you must 
choose sides (the NATO alliance or Syria’s opposing forces) 
and get ready for urban warfare in Combat Mission: Shock 
Force, a hybrid turn-based/real-time 3D WWII strategy game (a 
HTBRT3DWWIISG?). This latest entry in the Combat Mission series 
features missile systems, on-the-fl y targeting paths, armored-

vehicle defenses, and the same 
brand of deeply tactical gameplay 
that we’ve come to associate with 
the Combat Mission name.—MO

Combat Mission: Shock Force
Price TBD

Available 2006
Battlefront.com
www.battlefront.com

PLAY THE GAME, GET THE MUSIC
 Serious gamers know you can get great game soundtracks (such as the Final Fantasy saga) on iTunes. Now Electronic Arts is 

teaming up with Nettwerk Music Group to bring EA’s musical library to iTunes and other online music providers. Soon you’ll be 
able to download the soundtracks to 007 Nightfi re, the Medal of Honor series, The Sims, and even Tiger Woods PGA Tour 2005 
(you know how those golfers love to get down—especially John Daly).—Matt Osborn

TIPS & TRICKS: STUBBS THE ZOMBIE IN REBEL WITHOUT A PULSE
What is a pissed-off, undead salesman to do in the city of 
tomorrow? Bowl for dollars at the local Bowl-O-Rama, or 
create a lethal army of the walking dead? Stubbs the Zombie 
in Rebel Without a Pulse ($39.99, www.aspyr.com) invites 
you to do the latter, and these tips can help you cash in on all 
those brains you collect.—MO

• Your undead army is expendable. Push your zombies 
toward cops and other gun-toting humans to draw their 
fi re, then attack from the side.
• Have your decapitated arm hop onto the head of a human 
to possess him, and then use the human’s fi rearms to clear 
the area. 

Your mission: combat.
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It happens when you least expect it—something goes wrong while you’re 
installing the latest Mac OS X update. Perhaps the install simply fails during the 

process, or you get a mysterious message saying the update wasn’t complete. 
Here’s what to do to fi x the problem.

TRY AGAIN Run the updater again, even if your system appears to work 
normally after the failed update—all appropriate system components may not 
have been updated, which may cause problems later on.

TRY, TRY AGAIN If the above still results in a failed install, try booting from 
an alternate startup volume, and then run the updater—you can use another 
Mac or an external hard drive with OS X installed to boot the problematic system 
in FireWire target disk mode. Once booted from an alternate drive, select the 
problematic volume in the Finder, and press Command-I. Check the box marked 
Ignore Ownership Permissions On This Volume, and run the updater once more.

FOURTH TIME’S A CHARM That didn’t work either? Boot from the alternate 
startup volume again, but before you install the update, use a third-party disk-repair 
utility such as Alsoft’s DiskWarrior ($79.95, www.alsoft.com) or Prosoft’s Drive 
Genius ($99, www.prosofteng.com) to rebuild the problematic volume’s directory.

WHEN ALL ELSE FAILS If you experience more-severe issues after the failed 
update, try booting from the Mac OS X install disc, run the installer, and choose 
Archive And Install, which replaces your OS with an entirely fresh one. Then install 
the Mac OS X combo updater—and the next time Apple releases an update, don’t 
check email, surf the Web, render video, play iTunes music, or do anything else 
while you’re installing it. Just let the updater run; that will minimize the chances of 
an installation failure.

WHEN OS UPDATES GO BAD

• Eastgate Systems’ 
Tinderbox 3 
($149, on the Disc, 
www.eastgate
.com) is a content 
manager that helps 
you organize your 
notes, ideas, and 
plans. It now has 
better outlining 
tools, adjustable 
tab stops, and new 
query extensions, 
and more.

• Plum Canary’s 
Chirp 2.1 ($79, on 
the Disc, www
.plumcanary.com)
is a tool that helps 
you track the work 
being done by your 
project’s workers. 
New features 
include fl exibility 
in controlling 
access to project 
info, a better 
data display, and 
keyboard-shortcut 
improvements.

• Intex Publishing’s Faktura vX Pro 4 
($179, www.intex-publishing.de) is a 
FileMaker-based enterprise-planning 
system with modules for partners, 
products, orders, letters, contacts, and 
much more.

• MYOB’s AccountEdge 2006 ($299, 
www.myob.com) is a management and 
accounting app for small businesses. 
This new version features the ability to 
track seven years of transaction history, 
a new ordering and receiving inventory 
process, and new timesheets.

• To The Point Software’s TaskTime3 
($15, on the Disc, www.ttpsoftware
.com) tracks the time you spend on 
the work you do for your clients. New 
features include interface changes and 
an autosave that can be activated at 
specifi c intervals.

• Sonny Software’s Bookends 8.1.3 
($99, www.sonnysoftware.com) 
saves and formats references for 
bibliographies or footnotes. It works 

with Microsoft 
Word, Nisus Writer 
Express, and other 
word processors. 
—Michelle Victoria

NEW RAZR ROCKS
Now this is closer to what we were expecting 

when we fi rst heard about a mobile iTunes 
phone—one of Motorola’s wicked-cool RAZR 
phones, not the mini-brick ROKR. The RAZR V3i 
(price TBD, www.motorola.com) has features 
to drool over, including external and internal 
color LCDs, a mini-USB headset, Bluetooth, MP3 
ringtone support, and more—but a Motorola rep 
wouldn’t confi rm or deny whether iTunes tunes 
could be used as ringtones. The built-in 1.23-
megapixel digital camera (with 8X digital zoom, 
video capture, and a full-screen viewfi nder) is 
also an improvement; its specs alone embarrass 
the ROKR’s 640-by-480-pixel joke of a camera.

Now the bad news: The V3i uses the same 
iTunes client as the ROKR, so it still has the same 
100-song limit. And you still can’t purchase 
songs through the phone; you connect the V3i to 
your Mac and use iTunes to transfer your songs. 
One last catch: According to Motorola’s Web 
site, “iTunes is not available on all models in all 
regions.”

As for the ROKR, BusinessWeek reported 
that Motorola and Cingular are working on a 
revamped ROKR with a 1-megapixel camera and 
enough storage capacity to hold 1,000 songs.
—Roman Loyola What the ROKR should’ve been.

>>>>>>>>>>>>>>>>>>>>>>>>>>>>
Bug of the Month
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Tinderbox 3 helps 
you organize your 
thoughts.

ON THE
DISC

Chirp
TaskTime3
Tinderbox 3
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SHAREWARE PICK OF THE MONTH

iOrganize www.brunoblondeau.com $19.95

If you do a lot of writing, you’re probably looking for a better way to store and organize your notes and ideas than 
just saving random fi les on your hard drive. You’re probably looking for something like iOrganize.—Andrew Tokuda

 4   When you type your note in the large, 
white Notes fi eld, iOrganize automatically 
fi lls in the Note Title fi eld for you. Double-
click the Note Title to rename it something 
that makes more sense to you.

3  Highlight the category 
or subcategory under 
which you’d like to store 
your notes, and click the 
New Note icon.

2  To make a subcategory, 
highlight the category 
under which you’d like to 
add a subcategory (Work 
Stuff, in our example) and 
click the plus-sign/arrow 
button at the bottom.
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Intel 101
>>>>>>>>>>>>>>>>>>>>>
A MONTHLY GUIDE TO INTEL BUZZWORDS

VT
What it is: In the Intel world, 
VT stands for “Virtualization 
Technology,” known in 
an earlier incarnation as 
Vanderpool Technology. 
Virtualization technologies 
allow you to run more than 
one operating system on the 
same computer. Although 
current schemes are software 
based, Intel is in the process of designing hardware-based 
VT for implementation in its upcoming processor lines.
What the Mac equivalent is: In the Mac universe, virtualization 
is handled by software such as Microsoft’s Virtual PC, Lismore 
Software’s Guest PC, and others. The major Mac-based 
virtualization (aka emulation) apps allow you to run Windows 
on your Mac, but there are other emulators that support DOS, 
Apple II software, or even console games.
Why you should care: In addition to improving VT performance, 
hardware-based VT could allow you to boot different operating 
systems at different times, all running on the same Mac or PC. 
Current emulators such as Virtual PC run on top of Mac OS X, 
not independent of it. Theoretically, on a VT-enabled, Intel-
based Mac, you could independently boot and run, say, Mac OS 
X, Windows XP, and Linux. Whether or not future Macs allow you 
to do so may be decided more by Apple marketing than by Intel 
engineering.—Rik Myslewski

The iSkin Duo ($29.95, www.iskin.com) offer two layers 
of different-colored silicone to protect your iPod nano, 

complete with grip bumps so your nano won’t fl y out of 
your hands—but if it does, that’s OK, since the two silicone 
layers absorb most of the shock from a fall (at least that’s 
what iSkin says). You also get a polycarbonate screen 
protector, RevoClip2 belt clip, and iSkin Wheel Cap to cover 
the nano’s clickwheel.—Michelle Victoria

iPOD CASE OF THE MONTH

SUBMIT YOUR CASE Whether your iPod case is a custom-made one-off or mass produced, you 
can submit it for Case-of-the-Month consideration—just send it to iPod Case of the Month, MacAddict, 
4000 Shoreline Ct., Ste. 400, South San Francisco, CA 94080. Please note that we cannot return cases.

Layered 
for your 
protection.

 After you launch 
iOrganize, click the New 
Category icon to add a 
category. Add as many 
categories as you need.

ON THE
DISC

iOrganize
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..Good software doesn’t have to be 

..expensive. Meet the bargain apps 

..we voted Most Deserving of a 

..Place on Your Mac.

..by Jake Widman

52
MUST-HAVE APPS!

✁Clip ’n Save!

(That Won’t Break Your Bank     )

n Save!

Every 
year, a 
new crop 

of low-priced apps—
shareware, freeware, 
donationware, and more—
go out to face the world. Their 
developers look on proudly and hopefully 
as their creations vie for the hearts of Mac 
addicts everywhere (and maybe earn their creators some 
dough). We’ve examined the current contenders—both brand-new 
and updates—and found 52 that deserve a space in your Dock. From 
improving your health to helping your Mac run better, these apps will 

work hard for you—without costing you an arm and a leg. 
And they all work with both Mac OS 10.3 (Panther) and 10.4 
(Tiger), except where noted.

ON THE
DISC

Most of the apps 
mentioned in this 
story can be found 
on this month’s Disc.
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Graphics Tool Kit
Sometimes you need to do a lot to an image; sometimes you only want to 
do one or two things. Whatever your needs, these apps have you covered.

Image Tricks 1.1
www.belightsoft.com (Tiger only)

Image Tricks adds an 
interface to Tiger’s Core 
Image fi lters—now you 
can use Pinch Distortion 
to turn your dining room 
into a funhouse.

EasyCrop 1.9 
www.yellowmug.com

Drag a fi le onto one side to 
crop it, adjust the scaling 
on the other side, and drag 
away the new version, ready 
to email.

EasyFrame 1.2.5 
www.yellowmug.com

Ever thought a photo 
on your Web site would 
look cooler with a torn-
paper edge? Are you a 
scrapbooker looking to 
make an old-fashioned 
photo-corner effect? Open 
a photo in EasyFrame, pick 
a frame from the drawer, 
adjust it to your liking, and 
save your framed photo in 
the format of your choice.

Linotype 
FontExplorer X 
www.linotype.com

Dealing with fonts in OS X 
isn’t fun, and most of the 
good ways to make it easier 
cost money. FontExplorer X, 
from one of the oldest and 
most-respected names in 
the font biz, makes things 
easier with its informative 
main screen and creative 
sample possibilities.

The Free Three
Scott Moschella’s GIMPshop (left) is a version of the open-source 
GIMP (GNU Image Manipulation Program) that looks and works 
like Photoshop—check out the familiar tool icons. The open-source 
Inkscape (center) is an Illustrator-like vector-graphics editor with a 
strong array of object-manipulation features. (Both GIMPshop and Inkscape require X11, which is available free from www
.apple.com/downloads/macosx/apple/x11formacosx.html.) ArtRage (right) lets you choose from six art-creation tools—from 
left to right, a paintbrush, crayon, chalk, marker, palette knife, and pencil—to make just about any kind of picture you want.

GIMPshop 
2.2.4 
aka the 
Photoshop 
alternative 
(free, http://
plasticbugs.com)

Inkscape 0.43
aka the Illustrator 
alternative 
(free, www
.inkscape.org)

ArtRage 1.1
aka the 
Corel Painter 
alternative 
(free, www
.ambientdesign.com)

A Handful of Widgets
Dissing Dashboard may be the attitude du jour, but here are 
some widgets that might change your tune. First, when you 
start typing a name into EasyEnvelopes (right), it 
fi nds matching entries in your Address Book and 
automatically creates an envelope for you to print. 
PCalc (top) can handle more calculations than most 
of us will ever need—or even know the purpose of. 
(The download also includes a standalone version.) 
pearLyrics (center) searches the Web to fi nd the 
lyrics to the song you’re listening to in iTunes. With 
SnippetComposer (bottom), you enter HTML code 
into the top window and get a quick preview of the 
results at the bottom—if it looks the way you want, 
click the C button to copy it to the Clipboard. And 
after you’ve done all that productive stuff, unwind 

with SuperBrain (left), a widgetized version of the game 
Mastermind with a variable number of colors and columns.

PCalc 3 $19 
http://pcalc.com

EasyEnvelopes 
1.0.1 Free!
www.ambrosiasw.com

pearLyrics 0.6 Donationware
www.pearworks.com

SuperBrain 1.6.1 Free!
www.power4mac.com

SnippetComposer 
1.0.1 Free!
http://andrew.hedges.name

Free! $12 $20 Free!

✁
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A/V Club
Now that your Mac is the center of your listening, viewing, 
and editing world, these apps are here to help.

Home 
and Lifestyle

Whether pursuing your hobbies, running your home, or keeping 
tabs on your weight, one of these apps can brighten your day.

Diet Sleuth 4.3.1
www.blackcatsystems.com

It’s a little ugly and a 
little clunky, but it’s got 
a database of just about 
every food you’re likely to 
eat. Just select food items 
from the menus and enter 
them into meals, and 
you can keep track of the 
calories, fat, and sugar 
you consume each day—if 
you dare.

GarageSale 1.9.4
www.iwascoding.com

You can use GarageSale 
to prepare one or more 
auctions for eBay offl ine, 
preview them, and then 
upload them all at once. 
Included templates make it 
easy to post a nice-looking 
listing.

AuctionSieve 
1.7.4
www.auctionsieve.com

Tell AuctionSieve what you’re 
looking for on eBay, wait for 
it to retrieve all the auctions 
that match your criteria, then 
shop till you drop. 

Budget 4.6.2
www.snowmintcs.com

Set up an account 
envelope for whatever 
money’s coming in and 
virtual envelopes for 
your regular bills, and 
hope there’s enough in 
the former to fi ll all the 
latter—just like in real life. 
At least you won’t have to 
budget much for this app.

Salling Clicker 3
www.salling.com

Upload the app to your 
Bluetooth-enabled PDA or 
cell phone; then use your 
PDA or phone as a remote 
control for your Mac.

HyperEngine-AV 1.5 
www.arboretum.com

This is primarily a video-editing 
app, but it also does a fi ne job 
with plain old audio. You import 
clips, select the parts you want, set transition and fade 
effects, and then export your results in any of several formats.

iDive 1.4.5 
www.aquafadas.com

Need an album for all your 
digital video? iDive is like 
iPhoto for video, offering 
thumbnails that you can 
scrub through, labeling, 
and more.

Indy 
http://indy.tv

Indy streams songs by 
bands you’ve (probably) 
never heard of; rate songs, and Indy adjusts its playlist 
accordingly. Best of all, it even saves all the songs you hear.

SoundSource 1.0.5 
www.rogueamoeba.com

If you’ve got more than 
one input or output device 
connected to your Mac, 
SoundSource gives you an 
easy menu-bar way to switch 
between 
them or 
assign 
different 
kinds of 
output to 
different 
devices.

Kinoma Producer 3 
www.kinoma.com

Convert your digital video into a format 
you can play on your Palm OS PDA with 
Kinoma Player 3 EX ($19.99)—or just 
save it in MP4 or AAC format.

$29.99

Free! Free! $69.95

Free!

Free! $29.95 $34.99 $24.99

$23.95

✁
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Web Tool Kit
The compleat Web surfer requires more than just a browser. Here 
are some tools that’ll help you navigate the ’Net smarter and better.

Web Tool Kit
The compleat Web surfer requires more than just a browser. Here 
are some tools that’ll help you navigate the ’Net smarter and better.
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Fit the Purpose
Our two favorite FTP 
clients are easy to 
learn, simple to use, 
and have all the basic 
tools you need to 
transfer fi les and sync 
folders. Transmit has 
a few more features, 
but which interface 
you prefer is a matter 
of taste.

Cyberduck 2.5.2 
donationware, http://cyberduck.ch

Transmit 
3.2.1 
$29.95, www
.panic.com

Bargain Glossary
Bargain software comes in all forms, from low-priced commercial apps to absolutely free apps 
from the open-source movement. Here’s a guide to some of the shopping terms you’ll run into.

Demo “A special version of a program (frequently with some 
features crippled) which is distributed at little or no cost to the user 
for enticement purposes.” (Source: Answers.com)

Donationware “Donationware authors ask that anyone using their 
software make a donation to the authors or a third party.” (Wikipedia)

Freeware “Freeware is computer software which is made available 
free of charge. Freeware is typically proprietary, distributed without 
source code, and often carries a restrictive license.” (Wikipedia)

Nagware “The variety of shareware that displays a large screen 
at the beginning or end reminding you to register, typically requiring 
some sort of keystroke to continue.” (Answers.com)

Shareware “Software distributed on a trial basis through the 
Internet, online services, BBSs, mail-order vendors, and user groups. 
Shareware is software on the honor system. If you use it regularly, 
you’re required to register and pay for it, for which you will receive 
technical support and perhaps additional documentation or the next 
upgrade.” (Computer Desktop Encyclopedia)

Trial “A trial version, trial,  or piece of trialware is a … version of a 
product that only works for a limited period of time (and sometimes 
has reduced functionality).” (Wikipedia)

WareZ “Pirated software distributed over the Internet.” 
(TechEncyclopedia)

Taboo 0.3  
www.ocdev.com

Firefox users get a warning 
message when they try 
to close a window with 
multiple tabs open. Safari 
users don’t—unless they’ve 
installed Taboo, that is.

Donationware
JAlbum 6 
http://jalbum.net

Quickly build a photo album from 
a folder of images that can be read 
by any browser. JAlbum comes with 
25 album skins, and its built-in FTP 
capability lets you publish your 
album to the Web.

Free!

Speed 
Download 3 
www.yazsoft.com

By opening multiple 
connections to a server 
(when it’s possible), 
Speed Download does 
just what it says: It 
downloads things faster. 
It also offers direct fi le 
sharing with other Speed 
Download users.

$20

Little Snitch 1.2.1 
www.obdev.at

Firewalls are for stopping 
what comes into your Mac 
over the Internet—Little 
Snitch tells you what 
goes out. You can keep 
applications from checking 
with their developers’ 
sites, stop cookies from 
reporting your habits, 
or prevent any other 
communication you’re 
feeling paranoid about.

$24.95
URLwell 1.2.1 
www.enigmarelle.com

When you run into a URL in 
an email or on a Web site that 
you want to check out later, 
just drag it to URLwell in your 
menu bar. It’ll stay there until 
you visit that link, after which 
you can delete it if you want.

Free!

Watcher’84 1.4 
www.brunoblondeau.com

Got a few sites you like to 
check in on for breaking 
news? Watcher’84 keeps 
an eye on them for you and 
alerts you whenever anything 
changes in the live (non-
advertising) area of the page. 

$14.95
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App Extenders
Commercial software developers could learn a thing or three about convenience from these feature-enhancing cuties.
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Google Maps 
Plugin 2.2.1 
www.briantoth.com

Once installed, this plug-in 
lets you Control-click any 
address in your Address 
Book and choose Google 
Map For from the pop-up 
menu to see where the 
address is—assuming 
Google Maps knows the 
address.

1-Click Answers 
www.answers.com

After you install 1-Click 
Answers, you can look 
something up on Answers
.com by selecting the 
text or term and pressing 
the 1-Click Answers hot 
key; you can also choose 
application name > Services 
> 1-Click Answers. It comes 
in widget form, too.

Chat Transcript 
Manager 
www.unsanity.com

Instant messages are 
instant, but that doesn’t 
mean they have to be 
temporary. Chat Transcript 
Manager saves transcripts 
of your chats and lets you 
search by person, date, 
content, or other criteria.

MenuCalendar
Clock 2.1.1 
www.objectpark.net

Need to check your 
calendar quickly? 
MenuCalendarClock puts 
iCal in your menu bar—click 
the drop-down calendar 
to open the full iCal. (And 
it’s also available for 
Entourage.)

Album Cover 
Finder 3.3.16 
www.amphonicdesigns
.com/albumcoverfi nder
(Tiger only)

Play a song in iTunes, and Album 
Cover Finder retrieves the cover 
art from Amazon, ready to drag 
into iTunes. It can also get the 
album’s track listing and a 
catalog of all the artist’s album 
covers.

FileChute 1.9.2 
www.yellowmug.com

Drop a fi le into FileChute, 
and the app uploads the fi le 
to your iDisk and generates 
a link that you email to 
whomever you want to 
retrieve the fi le. FileChute 
also works with other 
WebDAV or FTP servers; it 
can even make archives of 
multifi le uploads on the fl y. 

TapDex 1.2.5 
www.yellowmug.com

Here’s a quick way to look 
someone up: Press a hot 
key to bring up the little 
TapDex window, start 
typing a name from your 
Address Book, and get a 
list of possible matches 
instantly.

$15 $18.95 $20 Donationware

$9 Free! Free!

• Charity address labels

• Cards with instructions for sign language

• Prizes for attending a time-share presentation

• Food samples at the farmer’s market, Costco, or 
department-store basements in Japan

• Tiny-spoon tastes at your local ice cream parlor

Real-World Shareware
Your Mac isn’t the only place you can run into shareware’s “try it out and only pay for it if you like it” 
concept. Here are some other opportunities to put the shareware ethic to the test:

✁
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✁
Interface 
Enhancers
Sure, Mac OS X’s Aqua interface is dandy—but no true Mac addict 
can resist the compulsion to tweak it to his or her individual taste.

Docktopus
www.startly.com (Tiger only)

You know the little “badge” that tells you how many unread 
messages are waiting in Mail’s Inbox? Docktopus adds new 
“badges”—not just to Mail—that give you message previews, 
let you pause iTunes or see what’s playing, and more.

$19.95

Filegazer 1.1
www.donelleschi.com

If you’re fond of 
hierarchical menus 
(and who isn’t?), 
you’ll fi nd what 
you’re looking for 
in Filegazer. Move 
your mouse to one hot spot to 
see your whole disk; move it to 
another to see just your home 
directory.

$19.95

LargeType
www.coldpizzasoftware.com

Ever 
looked up 
a phone 
number on 
your Mac, 
but your 
phone’s 
across 
the room? 
LargeType 
can help; it displays the phone number (or any text 
you select) large enough to be seen from a distance.

Donationware

Mouse Locator
www.2point5fi sh.com

When we come back to 
our 20-inch iMac screen 
after some time away 
and can’t fi nd our cursor, 
we’re grateful for Mouse 
Locator. One tap of a hot 
key (or just moving the 
mouse) pops up a couple 

of green circles (or our choice of downloadable graphics) 
around the cursor’s arrow—ah, there you are!

Free!

Textpander 1.2
www.petermaurer.de

Most of us have to type some kind of boilerplate text from time 
to time: “Yours truly,” “I’m so, so sorry,” “You’ll be hearing 
from our lawyers,” and so on. Textpander lets you assign text 
and graphics to a short keystroke sequence so you can drop in 
your oft-repeated text on the fl y.

Donationware

WindowShade X 4.0.2
www.unsanity.com

Who doesn’t miss the window-shade effect from the 
pre-OS X days? WindowShade X brings it back and pumps 
it up, letting you minimize in place with transparency or 
apply other groovy effects.

$10

It warms MacAddict Features Editor Jake 
Widman’s little heart to see how many people 

write free software for the Mac just because they 
want to make using it a better experience.
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Maintenance
Tool Kit
Think of these apps as dietary supplements for your Mac—not absolutely necessary, but health promoting.

Defaults Manager 
Beta 8 
http://kuwan.net

If you know what you’re doing in Mac 
OS X’s User Defaults database, use 
this to tweak the preferences. If you 
don’t know what you’re doing, steer 
clear—you could seriously harm things.

$20

Name Those Files 2.0.6 
http://homepage.mac.com/jonn8/ntf

If you ever need to rename a whole 
bunch of fi les (such as a roll of 
photos) at the same time, this is 
the way to go. The combination 
of custom and automatic settings 
gives you a broad range of 
fl exibility. 

$12.50

Preferential Treatment 
1.1.6 
http://homepage.mac.com/jonn8/as

Corrupt Preferences fi les can cause 
all kinds of hinkiness. Preferential 
Treatment (a front end to Unix’s plutil 
command) scans both your user and 
system preferences and lets you root 
out corruption.

Free!

Canadian and 
Czech Army Knives

Several front ends to the built-in OS X maintenance routines are 
available (yeah, we know we can run the routines from the Terminal 
if we want; we don’t). These two sacrifi ce some of the others’ 
eye candy, but they’re the most straightforward and easiest to 
understand we’ve seen.

Mac Pilot 2 
$9.95, www.koingosw.com (Tiger only)

Xupport 3 
$19, www.computer-support.ch

Oddball
Sometimes the most-interesting apps aren’t easy to categorize. Here’s a sampling of some quirky goodies.

iFlash 2.6.3 
www.loopware.com

Got a test coming up? Use 
your Mac as a study aid by 
bringing fl ash cards into 
iFlash. Make your own, or 
download prebuilt decks of 
cards for subjects ranging 
from cervical radiology to 
Latin poetry.

$11.95

Atomic Mac 6 
www.blackcatsystems.com

It’s elemental: Atomic Mac 
lets you see the periodic 
table of the elements the 
usual way or color-coded 
by properties you choose. 
Everything you ever wanted 
to know about aluminum is 
just a double-click away. 

$24.99

Fluid 2.6.1 
www.concepthouse.com

You thought the Flurry 
screen saver was trippy? 
Wait’ll you see Fluid. 
Crank up the Copper 
theme, or set up your own 
combination of surface, 
refl ection, 3D depth, and 
so on—and enjoy.

Donationware

Germs 1.2.5
www.factor-software.com

Get rid of all the germs 
before they multiply and 
overrun your environment. 
Germs is simple but 
addictive, just like a 
good game should be.

$19.95

✁
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L ike all of Apple’s iApps, iTunes is easy to use, and a lot of power hides beneath 
its brushed-aluminum hood—power you may not even realize is there. Want to 
fi ll your iPod with iTunes tunes from more than one computer? Are you a fan of an 

online radio show that doesn’t provide podcasts, but you want to listen to it in iTunes 
and on your iPod? Ever put a playlist in a folder and couldn’t get it out again? Want 
to use iTunes to create smaller versions of your songs and audiobooks for your shiny 
new iPod nano? How about using iTunes to watch TV shows and movies that you’ve 
recorded? If these and other iTunes questions keep you up at night, prepare to sleep 
soundly after you learn a few lessons at iTunes University.

By Brad Miser

There’s more to everyone’s favorite 
jukebox than meets the eye. 

Q. Can I add songs to my iPod from different iTunes Libraries 
running on more than one computer—including PCs? 
A. Sure—but you’ll pay for it in convenience. When you 
use one of iTunes’ automatic iPod-update options (iTunes 
> Preferences > iPod > Update All Songs And Playlists or 
Update Selected Playlists Only), a link forges between 
the iTunes Library through which the option is set and the 
iPod. Although an iPod can be linked to only one iTunes 
Library at a time, you can still add tunes to it from iTunes 
running on multiple Macs or PCs—but you’ll have to do it 
manually.

When one of the two automatic-update options is set 
and you connect your iPod to a different iTunes Library 
on a different Mac or PC, iTunes will prompt you asking if 
you want to change the link to the Library on this second 
computer. If you click Yes at this prompt, iTunes will 
change the link and replace the music—all of the music—
on your iPod with music from the second computer’s 
Library—not good if you’re a Twista fan and this second 
computer is stuffed with the collected works of Celine 
Dion. If you click No, the link will not change—and neither 
will the music on your iPod.

When you connect an iPod that’s linked to one 
computer to a different computer, you’ll see this.

When you click No, your iPod will mount on the second 
computer and appear in the Source list. To add songs 
to your iPod from the second computer’s Library, go to 
iTunes > Preferences > iPod, and set the iPod’s update 
option to Manually Manage Songs And Playlists—you’ll 
then be able to add songs from the second computer’s 
Library to the iPod by dragging them onto its icon. After 
the manual update option is set, you can connect the 
same iPod to as many computers as you’d like—Windows 
PCs included—and manually move songs onto it from 
each. The only kicker is that you can no longer use 
one of the automatic update options to keep the iPod 
updated; you have to keep it on manual update. If you 
turn on automatic update again, the iPod will link to the 
computer to which it is connected, and all its music will 
be replaced.  

Q. Can I add songs to my iPod from different iTunes Libraries 

Manage Multiple Macs Manually
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Share and Share Unlike
Q. I share my Mac with several other users. I’d also like to share 
my iTunes music with them. Can this be done? Can all the users 
on the same Mac share the same music fi les?
A. The answer to both questions is “Yes.” You can use iTunes 
Sharing to enable anyone who uses your Mac (or is on your 
network) to listen to all the music in your Library or only to 
specifi c playlists. They can’t, however, copy it into their own 
Libraries in order to create playlists, burn CDs, and so on. If you 
want users who have accounts on your Mac to be able to create 
their own playlists from the same music fi les, then you’ll need 
to set up iTunes so that all users can fully share music fi les. 

Sharing the easy way: iTunes sharing. To enable other users 
of your Mac to simply listen to your music, choose iTunes > 
Preferences > Sharing, and then check Share My Music. If you 
want to share all of your music, click Share Entire Library; if 
you want to share only selected playlists, click Share Selected 
Playlists and check the box for each playlist you want to share 
(only those playlists will appear in the other users’ Source lists). 
Type a name for your music source in the Shared Name fi eld. 
To require a password before another user can listen to your 
tunes, check Require Password, and enter the password in the 
fi eld. Click OK. The music you selected will be available for other 
users—but if you’re sharing over a network, playing tunes from 
the iTMS will require authentication by the purchaser.

When you reconnect your iPod back to your original Mac, 
you’ll see that the iPod is still set to manually update, since 
that information is stored on the iPod, not the computer. You 
can reset it to update automatically if you want, but you’ll 
replace all the songs you added manually from those other 
computers—unless you copy them off fi rst using an app such 
as Podworks ($8, www.scifi hifi .com).

Dope Out Dupes
Q. What’s the best way to fi nd and eliminate duplicate songs 
from my iTunes Library?
A. Choose Edit > Show Duplicate Songs. The Content pane will 
now show only songs in the Library that have identical names. 
(You’ll also see a Show All Songs button at the bottom of the 
window—click it to leave Displaying Duplicate Songs mode.)

Because iTunes identifi es what it considers duplicate 
songs only by name, be careful about deleting them. For 

example, if you have one studio and one 
live version of the same song, iTunes 
will identify them as duplicates if they 
have the exact same name—you should 
display more information in the iTunes 
Content pane to determine if songs are 
really duplicates or not. To do so, choose 
Edit > View Options. In the View Options 
dialog, check columns that will help you 
better identify duplicates. At minimum 
you should select Album, Artist, Bit Rate, 
Composer, Kind, Time, and Year. Then 
click OK. 

The columns you selected will 
appear in the Content pane—drag them 

around to arrange them in a more-useful order. For example, 
move the Artist, Time, and Kind columns to the left of the 
pane because these quickly identify songs that are really 
duplicates; for example, if the Time is different, the odds 
are that the songs are different versions. If all three of these 
columns are the same for two songs with the same name, 
there’s a good chance the songs are duplicates—but you 
might want to look at the other columns to make sure; for 
example, compare the Bit Rate to see if you have same song 
at a different encoding setting—you may want to keep both 
(see “Shrink to Fit,” p33).

If all the song info is exactly the same, it is very likely 
that the songs are duplicates and you can get rid of one or 
more of the duplicate versions. If you want to be even more 
precise about identifying and removing duplicates, there are 
apps that’ll help you locate duplicate tracks—take a look 
at iSweep ($15, on the Disc, www.davtri.com/index.py/
softwaredetail?id=3) or iTunes Dupes Barrier (free, on the Disc, 
www.hyperbolicsoftware.com).

Here are songs that 
iTunes thinks are 
duplicates—some 
really are, but some 
of them aren’t.

Q. I put a playlist in the wrong folder 
in my Source list. How do I get it out?
A. Drag the playlist that you want to 

move out of a folder to the left edge 

of the Source list; when you reach 

the correct location, the Source list 

will become highlighted with a thin 

blue box. Release the mouse button 

and the playlist will be moved outside 

the folder.

Q. My PowerBook died before I could 
deauthorize it. Now I can only play 
iTMS tunes on four Macs. Help!
A. ¡No problema! Simply go to the 

iTunes Music Store and access your 

Account Information screen. If you’ve 

authorized fi ve Macs, a Deauthorize 

All option will appear—click it to 

deauthorize all of them. You’ll need to 

reauthorize all your other computers, 

however, and you can only do this 

once a year.

Q. Is there a quick way to fi nd out 
what playlists I’ve put a song into?
A. Of course! Control-click any 

song’s title. A Contextual Menu will 

pop up that gives you instant access 

to functions such as converting 

fi les and assigning ratings, as well 

as what you’re looking for: a list 

of all the playlists that include that 

particular song.

Contextual Menus provide both 
information and power.

Q. Can I change what I want to put 
on my iPod shuffl e even when it’s 
not attached? 
A. You can display your iPod shuffl e 

in the Source list at all times by 

choosing iTunes > Preferences > 

iPod and checking Keep This iPod In 

The Source List. When you unmount 

the shuffl e, its icon will remain in the 

Source list, and you can update it as 

if it were physically connected. The 

next time you plug your shuffl e into 

your Mac, it will update to include 

the songs you added.

Q. I’m bored with the iTunes 
Visualizer—can I change it?
A. Sure—you can download 

Visualizer plug-ins from the 

Internet. Search the Web for 

iTunes Visualizer, or simply go 

straight to www.trinfi nitysoftware

.com/itunesplugins.shtml. Put the 

plug-ins and supporting fi les in 

/user name/Library/iTunes/iTunes 

Plug-Ins, launch iTunes, choose the 

visualizer you want from the bottom 

of the iTunes Visualizer menu, 

choose Visualizer > Turn Visualizer 

On, and then groove to your heart’s 

content. 

When you drag a playlist to the 
left edge of the Source list, it will 
move out of the folder it was in.

Quick 
Tune Tips 

You can enter info for multiple 
songs by selecting those tracks 
together, pressing Command-I, 

and then entering the common information into 
the appropriate fi elds.

Tip 
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In order to share music 
this way, you must be logged 
in and iTunes must be 
running—this means that to 
make your music available 
to other users of your Mac, 
you’ll need to have Fast User 
Switching enabled (System 
Preferences > Accounts > Login 
Options) so that more than 
one user can be logged in at 
the same time. The active user 
account determines the music 
that’s playing on your Mac. 

If your account is playing a tune and another user logs in using 
Fast User Switching, that user can switch tunes—but when you 
switch back to your account, your music will resume right where 
you left it.

Sharing the not-as-easy way: sharing music fi les. Instead 
of using iTunes Sharing, you might want to have all the users 

Show others how great your 
music taste is by sharing your 
music with them.

Q. I put a playlist in the wrong folder 
in my Source list. How do I get it out?
A. Drag the playlist that you want to 

move out of a folder to the left edge 

of the Source list; when you reach 

the correct location, the Source list 

will become highlighted with a thin 

blue box. Release the mouse button 

and the playlist will be moved outside 

the folder.

Q. My PowerBook died before I could 
deauthorize it. Now I can only play 
iTMS tunes on four Macs. Help!
A. ¡No problema! Simply go to the 

iTunes Music Store and access your 

Account Information screen. If you’ve 

authorized fi ve Macs, a Deauthorize 

All option will appear—click it to 

deauthorize all of them. You’ll need to 

reauthorize all your other computers, 

however, and you can only do this 

once a year.

Q. Is there a quick way to fi nd out 
what playlists I’ve put a song into?
A. Of course! Control-click any 

song’s title. A Contextual Menu will 

pop up that gives you instant access 

to functions such as converting 

fi les and assigning ratings, as well 

as what you’re looking for: a list 

of all the playlists that include that 

particular song.

Contextual Menus provide both 
information and power.

Q. Can I change what I want to put 
on my iPod shuffl e even when it’s 
not attached? 
A. You can display your iPod shuffl e 

in the Source list at all times by 

choosing iTunes > Preferences > 

iPod and checking Keep This iPod In 

The Source List. When you unmount 

the shuffl e, its icon will remain in the 

Source list, and you can update it as 

if it were physically connected. The 

next time you plug your shuffl e into 

your Mac, it will update to include 

the songs you added.

Q. I’m bored with the iTunes 
Visualizer—can I change it?
A. Sure—you can download 

Visualizer plug-ins from the 

Internet. Search the Web for 

iTunes Visualizer, or simply go 

straight to www.trinfi nitysoftware

.com/itunesplugins.shtml. Put the 

plug-ins and supporting fi les in 

/user name/Library/iTunes/iTunes 

Plug-Ins, launch iTunes, choose the 

visualizer you want from the bottom 

of the iTunes Visualizer menu, 

choose Visualizer > Turn Visualizer 

On, and then groove to your heart’s 

content. 

Not all visualizers are 
psychedelic. Some of the best, 
like Jewel Case (donationware, 
www.opticalalchemy.com) are 
both attractive and useful.

This music folder is accessible to anyone using this Mac.

The Browse button is replaced by 
the Burn Disc button when you 
select a playlist, but you still can 

access the Browser—just press Command-B.

Tip 

on your Mac share the same music fi les. Why? Several reasons. 
Maybe you and other users want to create playlists and burn 
CDs using the same music. Perhaps you want to save disk space 
by storing songs only once. It’s also possible that you want to 
keep an eye on what your kids add to their Libraries—can’t have 
the wee ones strobin’ to Fiddy’s “Poor Lil Rich,” now can we? 

To share fi les, move your iTunes Music folder to your Public 
(/user name/Public) folder. Rename the folder so it is more 
recognizable—we named ours shared_iTunes_Music (poetic, 
aren’t we?). Open iTunes > Preferences > 
Advanced > General. The path shown in the 
iTunes Music Folder Location fi eld should 
be that of the new location of the renamed 
folder (which should end in Public:your 
renamed folder:). If it’s not, click Change, 
navigate to /Public/your renamed folder, 
and click Choose. Uncheck Copy Files 
To iTunes Music Folder When Adding To 
Library. If you’re prompted to have iTunes 
move and rename the fi les in your new 
folder, click Yes.

Now log into another user’s account on 
your Mac. Open that user’s iTunes Music 
folder and drag any folders it contains into 
/Public/your renamed folder. You’ll be 
prompted to authenticate the action; click 
Authenticate, enter an administrator name and password, and 
click OK. The music folders will be moved to the public location. 
While still logged in under that account, launch iTunes, choose 
iTunes > Preferences > Advanced > General, and click Change. 
Navigate to /Public/your renamed folder, select it, click Choose, 
uncheck Copy Files To iTunes Music Folder When Adding To 
Library, and then click OK. At the prompt, click Yes. Now choose 
File > Add to Library. In the resulting dialog, navigate to /Public/
your renamed folder, select it, and click Choose. All the music in 
that folder will become available in that user’s Library, and he or 
she can do anything with the music except delete it.

Log into any other user accounts and repeat the previous 
steps to confi gure those accounts to use the same folder. Then 
switch back to your own account. In iTunes, choose File > Add 
To Library. In the resulting dialog, navigate to /Public/your 
renamed folder, select it, and click Choose. Any music the 
other users had that wasn’t already in your Music library will 
be added to it.

With iTunes set up like this, only you will be able to add 
new music because you’ll be the only one who has permission 
to change the music folder. When you want to import a CD or 
purchase music from the iTunes Music Store, do so from your 
account. You’ll then need to have the other users use the Add To 
Library command to add that new music to their libraries. 

Enter Vanilla Ice 
in the Search 
fi eld. Press 
Return, then 
Command-A; 
choose Edit 
> Clear, and 
click Remove in 
the dialog that 
appears. You’ll 
feel better about 
yourself.

Tip 
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Q. I want to add my favorite TV 
shows to my iTunes Library so I 
can watch them on an iPod. How 
can I pull this off?
A. With some expense and a little 

bit of work, you can put any TV 

show into iTunes and move it from 

there onto a video-capable iPod. 

Here’s how.

Adding TV recording capabilities 
to your Mac. First, you’ll need to 

get that late-night, cable-access 

program about Jell-O–wrestling 

philatelists onto your Mac. There 

are a number of ways to do 

this, but our favorite is by using 

one of Elgato’s EyeTV systems, 

which includes the hardware and 

software you need to watch and 

record TV on your Mac. There are 

several variants of EyeTV, starting 

with the EyeTV EZ ($149, www

.elgato.com) and moving up to 

the EyeTV 200 ($329) or EyeTV 

500 ($369) for HDTV. Note that 

the EyeTV EZ relies on software 

encoding, unlike the pricier 200 

and 500, which both do hardware 

encoding for noticeably better-

quality recordings.

Installing and confi guring an 

EyeTV system is a no-brainer. 

Connect the EyeTV hardware 

to a TV-signal source such as 

cable or an antenna, and then 

connect it to your Mac using USB 

or FireWire. After that, you install 

the EyeTV software and confi gure 

it using its Setup Assistant, which 

leads you through selecting 

the type of input you are using, 

identifying the channels you 

receive, and confi guring the 

onscreen guide for your TV 

source. When that process is 

complete, EyeTV will begin 

displaying live TV on your Mac.

To confi gure the EyeTV’s 

encoder, fi rst choose EyeTV > 

Device Settings. In the Encoding 

pane of the resulting dialog, 

choose your EyeTV device from 

the top pop-up menu. Then 

choose the quality level at which 

you want to record using the 

Quality pop-up menu—a good 

The low-cost EyeTV EZ (left) 
uses software encoding, 
while the EyeTV 200 (right), 
encodes in hardware.

Wiretap the Web
Q. Some of my favorite radio shows don’t offer podcasts; they 
provide episodes on their Web pages only in RealPlayer or 
Windows Media formats. How can I put these episodes in my 
iTunes Library so I can move them onto my iPod?
A. While many online radio shows have jumped on the 
podcasting bandwagon, some of your favorites might not have. 
Fortunately, you can use Ambrosia Software’s WireTap Pro ($19, 
on the Disc, www.ambrosiasw.com) to record any audio you 
can play on your Mac and add those recordings to your iTunes 
Library and iPod.

Install WireTap Pro, and make sure you have the audio app 
used by your target radio show—some use RealPlayer (www
.real.com/player), some Windows Media Player (www.microsoft
.com/mac), and some their own transparent proprietary 

scheme—from WireTap’s 
point of view, it doesn’t 
matter. Next, open iTunes 
and create a playlist into 
which you’ll store the 
show’s episodes—say, The 
Gentle Wit of Howard Stern.

Now it’s time to 
confi gure WireTap Pro to 
store recordings in the 
playlist you just created. 

Open WireTap Pro, choose WireTap Pro > Preferences, click the 
Source tab, and choose Mac Audio in the Source pop-up menu. 
Click the Saving tab, choose iTunes in the Save File To pop-up 

menu, and check Automatically 
Save Recordings. In the Playlist 
pop-up menu, choose the playlist 
you created earlier. Check the 
Application Name box and Prefi x 
box, give your fi les a name in 
the Prefi x fi eld, and then select 
Incremental in the Suffi x pop-up 
menu to number them sequentially 
when they’re added to iTunes.

Finally, click the Format tab, and 
choose AAC or the format of your 
choice in the File Format pop-
up menu. (You may also need to 
confi gure the format using the Settings button.) Click OK to 
save your preferences. Note that if you use an external USB 
sound-input device, you’ll need to set the output of your system 
to use the Mac’s internal sound circuitry by opening System 
Preferences > Sound, clicking the Output tab, and selecting 
Built-In Audio Port. You’re now ready to record.

Open WireTap Pro, browse to your favorite show’s Web 
site, and then click the link for RealPlayer, Windows Media, or 
another audio format. The audio will begin to play in the default 
app. While that’s happening, move back into WireTap Pro and 
click the Record button. When you want to stop recording, click 
WireTap Pro’s Stop button, and WireTap Pro will process the fi le 
and store it in your iTunes Library in the playlist you told it to in 
WireTap Pro’s Preferences.

Move into iTunes, and select the playlist you created to 
store the audio; you’ll see each fi le you just recorded, named 

Boob-
Tube Booty

Confi gure EyeTV to use an 
encoding option; higher 
quality settings use more 
disk space.

With EyeTV, you’ll be able to 
watch TV and move programs 
to your iPod.

With these settings, recorded 
audio will be stored in the radio 
playlist, and each fi le will be named 
radio_my_way sequential number.

While WireTap Pro is 
recording, you’ll see 
information about the 
audio being recorded at 
the bottom of the window.
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option with the EyeTV 200 is 

Standard (DVD 120 Min). 

Now you’ll need to select a 

volume on your Mac (preferably 

one with lots of available disk 

space) on which to store your 

saved TV fi les. Choose EyeTV > 

Preferences, click the Storage 

tab, click Change, and use 

the Choose A Folder dialog to 

choose where you want to store 

EyeTV programs. Check the Keep 

Live TV Buffer In RAM check 

box, and enter a reasonable-

size buffer in the Live TV Buffer 

Size fi eld. We recommend 50MB 

or more, but if you’re tight on 

RAM, you’ll have to use a smaller 

value—or buy more RAM, 

cheapskate. Click OK.

Recording TV shows on your 
Mac. After you’ve confi gured 

your EyeTV, using it to record TV 

programs is a snap. There are 

several ways to record:

• While watching a show, click 

the Record button on the 

EyeTV Remote. The program 

will record and show up on the 

EyeTV Programs list. This is a 

good option for serendipitously 

capturing obscure stuff such as 

the aforementioned Phighting 

Philatelists.

• Open the online content guide, 

Control-click a program’s 

listing to bring up its Contextual 

Menu, and choose Record. 

The program will be scheduled 

for recording—your EyeTV will 

record it automatically. (Alas, 

you can’t tell EyeTV to record 

an entire series automatically.)

• Choose Window > EyeTV 

Programs. Click the New 

button. Use the New Program 

Info window to schedule 

a recording by time and 

channel—if, of course, you 

already know the time and 

channel of your target program.

Whichever method you use, 

the programs you record will be 

listed in the EyeTV Programs 

window.

Exporting TV shows for an iPod. 
In the EyeTV Programs window, 

select the program you want 

to put on your ’Pod. Choose 

File > Export. In the Save As 

dialog, choose MPEG-4 in the 

Format pop-up menu, name 

the fi le, and choose a location 

to save it. Click Options, and 

in the MPEG-4 Export Settings 

dialog, choose 320 x 240 QVGA 

in the Image Size pop-up menu. 

Click OK, and then click Save. 

Depending on the length of the 

program and the power of your 

Mac, the export process can take 

a few minutes or quite a while. 

When the process is complete, 

the show will open in QuickTime 

Player (if you didn’t disable that 

preference). 

Moving recorded TV shows onto 
an iPod. After the show has been 

exported, moving it from iTunes 

to your video-capable iPod is 

simple. Open iTunes and choose 

File > Add To Library. Navigate 

to and select the TV show you 

exported from EyeTV, then click 

Choose. The exported fi le will be 

added to your iTunes Library. The 

next time you update a video-

capable iPod, the program will be 

moved onto your ’Pod—prepare 

to be amazed at the image quality 

of the show.

according to your preferences. You can play the audio within 
iTunes or move it to your iPod—to do the latter, make sure the 
desired playlist is among those you’ve confi gured to be updated 
on the iPod.

Shrink to Fit
Q. I’ve imported an entire unabridged audiobook of War and 
Peace at 160 Kbps, but now I want to shrink the fi les to 96 Kbps 
so I can fi t everything on my iPod nano. Can I just convert them, 
or do I have to re-import them?
A. You can convert audiobook chapters or songs from one 
format to another without re-importing them. But before you do, 
realize that each time you convert a song, you create another 
copy of it and add another entry in your Library, making fi le-
management more complicated. But if you want to be able to 
listen to a higher-quality version on your Mac while having a 
smaller version for your iPod, it can be worth the hassle.

To convert songs to a smaller fi le size, choose iTunes > 
Preferences > Advanced > Importing, and then choose the 
encoder you want to use (such as AAC Encoder or MP3 Encoder) 
from the Import Using pop-up menu. Then use the Setting 
pop-up menu to choose a lower quality level (and thus a smaller 
fi le size), such as Spoken Podcast for AAC or Custom > 96 kbps 
for MP3. Click OK. Select the songs you want to shrink, and 
then from iTunes’ main menu, choose Advanced > Convert 
Selection To encoder (the encoder will be the one you selected 
previously). During the conversion, the Converting icon will 
appear in the Source list; when the conversion is complete, 
you’ll see two versions of each of the songs you converted.

Dealing with multiple versions of the same songs can be 
confusing. To determine which version is which, select a song 
and press Command-I to open the Info window. In the Summary 
tab, you’ll see the Bit Rate and Format for that song. Here are 
some suggestions for handling multiple versions:
• Add a notation to the names of the lower-quality versions 

of your songs so they’re easy to spot—LQ, for example.
• Create a smart playlist with a single criterion—the Bit Rate 

of the lower-quality music—to collect all 
the lower-quality music in one playlist. 
Use it to create other playlists.

• Create smart playlists based on Artist, 
Album, or whatever, and add Bit Rate 
to the search criteria. This will collect 
songs of the same quality level into 
those smart playlists.
If you want to fi t more music on your 

iPod, use the lower-quality versions. The 
easiest way to do this is to set your iPod 
to automatically update only selected 
playlists, and then choose only the lower-
quality playlists. 

Use this dialog to confi gure an 
exported show for your video-
capable iPod.

To incrementally 
back up items 
as you add them 
to the iTunes 
Library, create a 
smart playlist that 
fi nds fi les added 
in the past x 
days, and burn it 
to CD or DVD.

Tip 

Add Bit Rate to the search criteria of smart playlists to 
organize music of which you have multiple versions.
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Use an image-editing app, and you can quickly get lost in a forest of arcane terminology—an indigestible mix of darkroom lingo 
from the pre-digital era, gnarly geek speak, plus a little bit of English thrown in for fun. Here, we’ve compiled some of the 

repeat offenders into a handy translation guide. Keep it next to your Mac, and fi x your photos without fear.

Darkroom Lingo
Photographers were editing images long before the invention of the Mac. These digital tools and techniques are throwbacks to 
those analog days—and no image-editing app is complete without them.

BRIGHTNESS
The overall lightness of a photograph. Increasing brightness 
lightens the tonal range of a photograph across the board, 
reducing contrast (see below). Too much brightness makes 
a photograph look faded and washed out. 

BURNING AND DODGING
Techniques for darkening or lightening an area of a photograph, 
respectively. Originally, photographers accomplished these 
tasks during print making by exposing parts of the print for 
longer (burning) or lesser (dodging) periods of time. 

CONTRAST
The tonal distance between the brightest and darkest values 
in a photograph. Increasing the contrast widens that distance, 
expanding the tonal range. A little more contrast is almost 
always good.

CROP
A technique for removing unwanted sections of a photograph by 
redrawing its boundaries—anything outside the new boundary is 
discarded.

EXPOSURE (OVER- AND UNDER-)
An overexposed photograph is one that was shot with too 
much light—colors appear washed out and bleached. An 
underexposed photograph is one with too little light—colors 
appear dark and faded.

PANORAMA
An extremely wide-angle photograph, often produced by 
stitching together a series of individual photographs. 

RED EYE 
When a fl ash is fi red into a subject’s eyes at close range, 
the subject’s retinas refl ect the red portion of the light. That 
refl ection is captured in the photograph—making your subject 
look like a demon.

SHARPEN
A software-based fi lter that enhances detail by increasing the 
differences in color and contrast of adjacent pixels. Sharpening 
can make an out-of-focus photograph presentable or tease more 
detail out of an already-presentable picture. Too much sharpening 
can make a photo look grainy.

HISTOGRAM
A histogram is a graph 
of the amount of image 
data throughout the tonal 
range of your image, with 
darker values on the left 
and lighter values on the 
right. A fl at area or break 
indicates a part of the 
spectrum that doesn’t 
appear in your image. 
TIP: To improve your 
photo using iPhoto’s histogram, move the right-hand slider to the 
left until it just meets that end of the graph. That sets the whitest 
point in the image. Move the left slider to the right to set the 
blackest point. Finally, use the Exposure slider (or Photoshop’s 
middle slider) to set the middle ranges to your liking.

Field Guide to IMAGE-EDITING TERMS

TIP: BURNING 
AND DODGING
The dodge and burn tools 
(see defi nition, above) 
in Photoshop work fairly 
well, but they have one big 
drawback: They permanently 
alter the pixels you use them 
on. Here’s a risk-free way to achieve the same effect.
     From the Layers palette, choose New Layer. (For this trick, you 
can’t use the New Layer button at the bottom of the palette). 
Choose Overlay from the Mode pull-down, and check the box below 
to fi ll it with 50% gray. Next, choose a soft brush of an appropriate 
size and set the Opacity to about 5%. Set your Foreground and 
Background colors to black and white. Paint with black on the new 
layer, and watch your image gently darken; paint with white to 
lighten it. If you paint it too dark, just go back over it with white. 

An Overlay layer lets you darken or 
lighten your image without fear. 

Manipulate the histogram to bring 
out more detail in your photo.

Image Is Everything
By Johnathon Williams
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Geek Speak
Digital photography and editing have created a slew of terms that would have left Ansel Adams scratching his head. 
These are the ones you can’t live without.

ANTI-ALIASING
Technology that creates the appearance of a smooth edge on 
graphics, type, and other images. Anti-aliasing blends the colors 
of pixels along a line or edge to provide a more-gradual transition 
and reduce the appearance of the stair-step pattern often referred 
to as jaggies.

COLOR PROFILE
A fi le that defi nes the gamut (see below) and color calibration of a 
particular monitor or printer. Magazine publishers, poster printers, 
and other professional prepress environments use profi les 
to ensure that color is accurately translated from the screen 
into print. With an advanced printer such as the Epson Stylus 
Photo R800 and an advanced image-editing app such as Adobe 
Photoshop, you can take advantage of profi les, too.

FEATHERING
A method for softening the edges of a selected area within 
an image. Feathering is especially useful when cutting out an 
element for pasting into another photograph; meddling becomes 
less obvious as the seams become less defi ned.

GAMUT
The range of color that can be captured or reproduced by a 
particular device. A digital camera, LCD display, and color printer 
all have different gamuts. The greater the gamut offered by a 
device, the more realistic its image reproduction can be. 

GAUSSIAN BLUR
A softening fi lter that blurs an image according to a Gaussian, or 
bell-shaped, curve. (The math behind the curve is based on the 
work of German mathematician Carl Gauss.) A gentle pass 

with this fi lter can create smooth-looking skin in a portrait—think 
glamour shots—but too much makes an image appear out of 
focus. Gaussian Blur is also useful for making digital noise less 
prominent.

MASKING
A technique for blending separate images together using the 
boundaries of one image to defi ne a transparent area in another. 
This is also a way of protecting bounded parts of an image from 
changes you’re making to other parts.

RAW
The image-fi le format of choice for professional photographers, 
RAW captures all of the data recorded by a digital camera’s 
sensors with zero compression. The result is larger fi le size 
(compared to JPG, though not to TIFF) and unparalleled quality. 
Once the exclusive purview of high-end cameras and image 
editors, it has since become available in midrange products.

RESOLUTION
The size of a digital image measured in horizontal and vertical 
pixels. Because greater resolution provides more detail in an 
image and more options for print size, the higher the resolution 
of your digital camera or scanner, the better chance you have of 
getting a high-quality image. 

UNSHARP MASK
Contrary to its name, this fi lter increases the sharpness of an 
image. It differs from the ordinary sharpening fi lter by offering 
more-advanced controls that allow the user to select which pixels 
are sharpened and fi ne-tune the degree of sharpening.

LAYERS
Layers separate elements in an 
image so that they can be adjusted 
independently of one another. 
In Photoshop, you reveal or hide 
layers by clicking the eye icons in 
the Layers palette; controls at the 
top let you determine how a layer 
interacts with the one below it. You 
can change the order by dragging 
them up or down the list in the 
Layers palette. 
TIP: The Background layer is a 
stubborn one! It won’t budge—unless 
you double-click it in the Layers 
palette. After that, it will behave like 
any other layer.

TIP: HIGH-PASS 
SHARPENING
Unsharp Mask (see defi nition, above) is a 
sophisticated tool that can be diffi cult to 
use. Here’s a different way to sharpen that 
gives excellent results—and is permanently 
undoable. First, copy your image onto a new 
layer (Command-J). Go to Filter > Other > High 
Pass, and choose a radius of about 7.0. Click 
OK. Then choose Soft Light from the blending-
mode pull-down menu. Bam! Your image is 
sharper. Reduce the opacity of the top layer 
if you think the effect is too strong. Because 
this method mostly sharpens your image’s 
edges, it doesn’t create as much noise. Plus, 
you can always delete the sharpening layer if 
you want to abandon ship.

Layers can be dragged to alter 
the order in which they appear.

Try this one-two 
punch for smoother 
sharpening.

Johnathon Williams spends more time with Photoshop than with his family, a fact that his wife is expected 
to present in court. (Not really.) Find out more about him at www.johnathonwilliams.com.



What’s better than a product with immediate 
visual impact? How about a product that backs 
up its good looks with excellent execution, such 
as Altec Lansing’s inMotion iM7 (pictured)? The 
same can be said about Palm’s new TX handheld 
PDA and Apple’s Power Mac G5 Quad. Freeverse’s 
Comic Life Deluxe Edition may not sound like 
much, but trust us—software should always be 
this fun and easy. Next month, we’ll take a look 
at Apple’s Aperture, cases for your iPod nano, 
Ableton’s Live 5, Canon’s Huey (Dewey and Louie 
were no-shows), and a lot more.

50 Comic Life Deluxe Edition comic-construction software
51 Creatures: Village simulation game
44 DeBabelizer Pro 6 media-processing software
46 iMaginator image editor
49 inMotion iM7 iPod speaker stand
39 LaCie silverscreen media player
49 Mercury Elite-AL PRO 800 RAID RAID array
54 Myst V: End of Ages Limited Edition 

graphic-adventure game
45 Perfection 4490 Photo fl atbed photo scanner
47 Pixma iP6600D inkjet printer
38 Power Mac G5 Quad 2.5GHz G5 tower
52 PowerShot A410 point-and-shoot camera
48 Selphy CP510 photo printer
53 ScanSnap fi-5110EOXM document scanner
40 TX handheld PDA
42 W800i Walkman mobile phone
40 Z22 handheld PDA

PLUS: 
TheHotList
55 The best of the best 

from recent reviews.

We’d spend our 
own hard-earned 
money on this 
product.

Compatible with 
Mac OS X or later.

Compatible with 
Mac OS 9 or earlier.PH
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You’ll be 
impressed.

You’ll be 
satisfied.

You’ll be 
disappointed.

You’ll be 
pissed off.

RATIN¬S

You’ll be 
blown away.
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How many PowerPC processors does 
it take to make the world’s fastest 

desktop Mac? Four. OK, on paper, the 
Power Mac G5 Quad 2.5GHz has two 
processors, but as we explained in 
“New Power Mac G5s: Big Iron” (Jan/06, 
p27), each of the Quad’s IBM 970MP 
processors is essentially two processors 

cheaper, third-party reseller and install 
it yourself, which is a snap). The stock 
video card is a 256MB nVidia GeForce 
6600 that’s capable of running Apple’s 
30-inch Cinema Display (  
Feb/05, p36). You get dual Gigabit 
Ethernet ports so you can, for example, 
connect to an Xsan storage network 

other recent top-of-the-line Power Macs, 
we didn’t notice these subtle speed 
improvements.

We fi rst ran a series of tests using 
popular apps on both the Quad and 
a dual 2.7GHz Power Mac G5 with the 
stock 512MB RAM confi guration. (We 
ran all of our tests with the processor 
performance set to Highest in System 
Preferences > Energy Saver > Options.) 
We saw an 11-percent speed increase 
on the Quad when performing a complex 
Photoshop CS2 Action on a 100MB 
fi le and a 25-percent increase when 
exporting video in iMovie HD. The Quad 
was 11-percent faster when running 
Unreal Tournament 2004’s fl yby and 
botmatch tests. When creating a DVD 
image in iDVD and importing Alex Wise’s 
Front Porch music CD in iTunes, both 
Power Macs clocked similar times—
the SuperDrive is the performance 
bottleneck.

However, if you use apps that can 
take advantage of a load o’ RAM, you’ll 
see bigger improvements. For example, 
Adobe Photoshop’s performance 
increased dramatically—by 40 percent—
when we boosted the Quad’s RAM from 
512MB to 1GB. When we went from 
512MB to 4GB, we saw an 80-percent 
increase. “Wow!” is an understatement.

Like previous top-of-the-line Power 
Macs, the Quad is liquid cooled. We 
noticed fan noise during processor-
intensive tasks, but it’s not as apparent 
as it is with the dual 2.7GHz Power Mac 
G5. The Quad makes the most noise when 
you insert a disc into its SuperDrive—it 
reminded us of a plane taking off.

The bottom line. With its $3,299 
price tag, the Quad isn’t for everyone, 
and adding RAM (you’d be crazy not to) 
pushes the price up further. The Quad is 
ideal for pros who process large fi les on 
a regular basis—video, audio, images, 
3D art and animation, and so on. There’s 
a whole lotta power under this baby’s 
hood.—Roman Loyola

Power Mac G5 Quad 2.5GHz
POWER-PACKED TOWER MAC

COMPANY: Apple
CONTACT: 800-795-1000 or 
408-996-1010, www.apple.com
PRICE: $3,299

SPECIFICATIONS: Two dual-core 2.5GHz PowerPC 
G5 processors, 512MB of 533MHz DDR2 SDRAM, 1MB 
L2 cache per core, 250GB SATA hard drive, SuperDrive, 
256MB nVidia GeForce 6600 video card

GOOD NEWS: Four processors in one Mac! 
Woo hoo!
BAD NEWS: Pricey. Built-in PCIe is not 
backward compatible with AGP and PCI-X cards.

Added slots: One more 
Ethernet and one more 
USB.

Remember Apple’s Quadra 
line? It’s back—sorta.

on one chip. Two dual-core processors 
equal four single-core processors, giving 
the aptly named Power Mac G5 Quad the 
processing power of four G5 processors.

That’s not the only thing to get excited 
about. There’s a lot of new hardware in 
the Quad, such as DDR2 memory and 
a maximum RAM capacity of 16GB (the 
Quad comes stock with 512MB—you’ll 
probably want to buy more from a 

and the Internet at the 
same time. Bluetooth 
and AirPort antennae 
are now internal—a 
nice touch. Finally, 
PCI Express (aka 
PCIe) expansion 

slots replace the older 
PCI-X and AGP slots; the new serial 
architecture is fast, but unfortunately, 
PCIe isn’t backward compatible with PCI 
and AGP cards.

Speed. In general, everything about 
the Quad feels noticeably faster than 
the dual 2.7GHz Power Mac G5—Finder 
windows are snappier, apps with 
notoriously long startup times (such as 
Adobe’s Photoshop) launch faster, and 
documents open more quickly. It may 
seem trivial to point that out, but we’re 
pointing it out for a reason: When testing 
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T here’s a confounding disconnect 
between your TV and the audio, 

pictures, and videos on your Mac. 
Fortunately, there’s LaCie’s 
silverscreen, a hard drive with 
a built-in software interface 
that offers a refreshingly 
manageable way to display 
your Mac media on your TV.

To load video, photos, or audio 
fi les onto silverscreen, you simply 
connect it to your Mac via USB with the 
included USB cable. (If your USB port 
doesn’t provide enough juice to power 
the silverscreen, LaCie includes a dual-
port USB plug that connects to both 
the USB cable and an included power 
adapter.) Once the drive mounts on 
the desktop, you drag the fi les into the 
appropriate folders: photos (JPEGs only) 
into Pictures, audio (WAV, MP3, AC3, 
and unprotected AAC—sorry, no music 
from the iTunes Music Store) into Music, 
and video (AVI, DivX, and XviD MPEG-4; 
AVI, VOB, and ISO MPEG-2; and MPEG-1) 
into Movies.

There is one catch: The silverscreen 
is preformatted as a FAT32 drive, so 
that means it has a fi le-size limit of 
4GB. If you have videos that are bigger 
than 4GB, either fi gure 
out a way to cut down 
the size, or reformat 
the silverscreen as an 
HFS+ drive. You can do 
this with the included 
silverscreen software 
CD, but that comes with 
another caveat: LaCie 
preformats with FAT32 
because it’s the only 
format that offers cross-
platform reading and writing. HFS+ 
can’t mount on Windows PCs. If you 
have access to Windows, you can opt 
to reformat the silverscreen as an NTFS 
drive—but then your Mac would only be 
able to read from the silverscreen and 
not write to it.

LaCie includes a cable that lets you 
connect the silverscreen to your TV 
via composite video or S-Video; it also 
includes a standard European Scart RGB 
adapter. You use the included power 
adapter to power the silverscreen when 
it’s attached to your TV. The silverscreen 
also comes with an S/PDIF cable so you 
can play audio through your home-
theater receiver, but you’ll need a TV 
and the included remote to navigate 
the interface. Simply select one of the 
four onscreen icons—Movies, Music, 
Pictures, and Settings—to get going.

The remote control is chock-full o’ 
buttons, but unfortunately, it’s not 

intuitive. We had to 
constantly look at the 
remote to press the 
correct navigational 
buttons, and there’s 
no tactile way to tell 
the difference between 
buttons. Some of the 
buttons, such as the 
volume controls, felt 
awkwardly placed. And 
while the remote is light 

and thin, it has no backlight, making it 
almost impossible to see in a dark room.

That’s entertainment. While the 
remote is confusing, the silverscreen 
software interface is a breeze to 
navigate—it’s a lot like navigating 
through a DVD movie. After you select 

 the media icon from the opening 
screen, you’re taken to a list of the 

appropriate fi les on the silverscreen. For 
example, if you select Pictures, the next 
screen shows a list of pictures, each 
with a thumbnail. To play or view the 
fi le, you select it using the navigation 
buttons and press Play Enter on the 
remote. Automatic slide shows (sans 
music—boo!) for pictures and shuffl e for 
audio are also available.

When manually navigating through 
a series of photos or sound fi les, 
we experienced noticeable lag. For 
example, when viewing pictures, 
there was a fi ve-second gap between 
the time we pressed the remote’s 
Next button and when the image 
appeared. Unfortunately, there’s no 
visual indicator to tell you that a fi le 
is loading—that would have stopped 
us from mashing the remote buttons 
because we thought the silverscreen 
didn’t receive the remote’s signal.

Pictures and movies from the 
silverscreen look great, and audio is 
quite good. Overall playback quality, of 
course, depends on the quality of your 
fi les—what bit rates you used for sound, 
compression levels for your JPEGs, and 
so on—but the silverscreen doesn’t 
degrade media quality.

The bottom line. Despite some of its 
quirks, the silverscreen takes little effort 
to set up and use, and the payoff is big. 
It’s nice to have a simple method of 
viewing media from your Mac on your TV. 
No muss, little fuss.—Roman Loyola

LaCie silverscreen
SIMPLE-BUT-EFFECTIVE MEDIA PLAYER

Silverscreen’s software interface 
makes it easy to get to your 
picture, movies, and music.

COMPANY: LaCie
CONTACT: 503-844-4500, www.lacie.com
PRICE: $219.99 (40GB), $279.99 
(80GB, tested)

REQUIREMENTS: USB-
equipped Mac; Mac OS 9.x or 
later; display or TV with RCA, S-
Video, Scart, VGA, or YPbPr input

GOOD NEWS: Compact. Easy to use. Offers drag-and-drop 
file transfers.
BAD NEWS: Can’t play music with slide shows. Can’t 
navigate controls while playing music. Confusing remote.

Here’s 
the link 

between your 
television and the 

music, pictures, and 
videos on your Mac.
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Palm’s new PDAs, the TX handheld 
and Z22 handheld, are two very 

different devices geared toward two 
very different users. The TX is a feature-
rich, viable alternative to your ’Book, 
while the Z22 simply acts as a digital 
replacement for your paper-based date 
and address books.

TX handheld. Not everyone wants to 
lug a laptop on the road just to check 
email. The TX proves to be a sturdy, 
affordable alternative. Equipped with 
Wi-Fi, Bluetooth, and a luxuriously large 
screen, the TX lets you quickly browse 
the Web or catch up on email whenever 
you’re in range of a Wi-Fi hotspot.

Measuring 4.8 by 3.1 by 0.6 inches 
and weighing 5.25 ounces, the TX packs 
powerful features into its slim package. 
It has a simple matte black fi nish that 
provides a nice, subtle frame for the 
ultrabright, gorgeous 320-by-480-pixel 
display. A row of buttons along the 
bottom of the screen lets you easily 
call up the writing area (or onscreen 

keyboard) when you need it, as well as 
turn the display to landscape mode for 
reading email, browsing Web pages, or 
looking at horizontal photos.

Using the TX’s built-in Wi-Fi couldn’t 
be simpler. To enable it, you just click 
the Wi-Fi button located at the bottom of 
the screen to scan for nearby networks. 
Calling up the Blazer Web browser or 
checking for email automatically prompts 
the TX to connect to a network. Because 
Blazer is a full-on HTML browser (most 
handheld devices have special browsers 

that render special Web 
pages designed for the 
small screen), we had 

to do a lot of scrolling 
to fi nd what we were 
looking for on CNN.com’s 
overcrowded home 
page. The VersaMail 
email app is a breeze 
to set up thanks to the 
inclusion of profi les 
for common services, 
including Mac.com, 
Gmail, and AOL. All we 
had to do was enter our 
user name and indicate 
that we had a .Mac 
account—the TX fi lled 
in the rest, and we were 
receiving mail within a 
minute. The TX syncs 
contact information 
with your Mac, so 
VersaMail autofi lls any 
email addresses that 
you have stored.

The TX isn’t all 
business. It also has 
the Pocket Tunes 
music player for 

playing MP3s; unfortunately, there’s 
no support for music purchased from 
the iTunes Music Store. To listen, just 
load your music up on an SD card and 
stick it into the unit’s SDIO slot. Tunes 
play through the integrated speaker, 
or you can plug headphones into the 
jack on top. Unlike on some previous 
Palm devices, music played smoothly—
without stopping or stuttering—even 
when we were browsing the Web or 
sending fi les via Bluetooth. We do have 
one aural complaint, however: The 

COMPANY: Palm
CONTACT: 800-881-7256, www.palm.com
PRICE: $99
REQUIREMENTS: USB-equipped Mac, 
Mac OS 10.2.8 or later

GOOD NEWS: Affordable. Simple controls. 
Super small and lightweight.
BAD NEWS: Chintzy body.
Hideous low-res display.

Z22 handheld
COMPANY: Palm
CONTACT: 800-881-7256, www.palm.com
PRICE: $299
REQUIREMENTS: USB-equipped Mac, 
Mac OS 10.2.8 or later

GOOD NEWS: Wi-Fi. Beautiful high-res screen. 
Email and Web on the road.
BAD NEWS: Odd speaker 
location. So-so battery life.

TX handheld

TX handheld & Z22 handheld
CONTRASTING PALM PDAS

Whether the TX (right) or Z22 (left) is the right handheld for you depends on what you want your PDA to do.
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We’re truly smitten with the W800i 
Walkman. This little wonder 

isn’t just a phone, music player, and 
2-megapixel camera in one small, 
convenient package—it’s what 
Motorola’s ROKR iTunes phone 
(  Dec/05, p40) should have 
been, and proof that a mobile phone 
can indeed replace other gadgets in 
your pockets.

The W800i’s music player is its best 
feature. The included 512MB Memory 
Stick Pro Duo card holds about 110 
songs (you can buy cards with more 
capacity). To transfer songs to the 
phone, just connect it to your Mac 
with the included USB 2.0 cable, and 
then either use the Finder to drag 
MP3 or unprotected AAC fi les to the 
phone’s mounted memory card, or get 
a third-party utility such as Dreamsicle 
($11.95, http://kaisakura.com) or 

iTuneMyWalkman (free, on the Disc, 
http://ilari.scheinin.fi disk.fi ) to transfer 
music and existing playlists from iTunes. 
You can easily build playlists directly in 
the phone, as well. 

Music limits. Sadly, the W800i can’t 
play the copy-protected tracks you buy 
from the iTunes Music Store. Freeware 
apps such as JHymn (free, http://hymn-
project.org) can strip copy protection 
from your iTunes tracks so you can play 

them on the W800i, but such tampering 
is illegal—at least in the United States. 

To play tunes, just press the W800i’s 
Walkman button, and then use its 
straightforward menus to choose a 
track, artist, or playlist. Music plays 
through in-ear headphones that include 
a mic for voice chats—the sound quality 
is slightly weaker than what you get 
through iPod buds. You can tweak the 
sound with a built-in equalizer, and the 
phone’s tiny stereo speakers sound 
surprisingly good. The W800i’s menus 
and other features work smoothly while 
it’s playing music, and the phone can 
pause music when you make or take 
a call. The W800i has no bookmark 
feature, however, which makes it a bad 
choice for long-form audiobooks and 
podcasts. 

Shutter to think. The W800i’s camera 
is fi rst-rate. Use the phone’s 178-by-220-
pixel screen to frame your subject, and 
snap your pic with a dedicated shutter 
button (you can turn on a fl ash-like light 
for shots in dim settings).

The W800i’s pics are the sharpest 
we’ve seen from a camera phone, and 
at 2 megapixels, they’re big enough 
to crop and still maintain detail—or 
even print. You can use a wireless 
Bluetooth connection to transfer pics to 
your Mac, but using a USB connection 
automatically triggers iPhoto, which 
recognizes the W800i as a camera so 
you can import pics straight into your 
photo albums. 

The W800i’s battery lasted us a 
couple of days, despite hours of phone 
chats and music listening. The phone’s 
menus are speedy and well organized, 
and we had no problems using iSync and 
Bluetooth to transfer our iCal events and 
Address Book contacts, including street 
addresses and multiple phone numbers 
per contact. 

The bottom line. The W800i is the 
fi rst phone we’ve found that can truly 
replace our iPod shuffl e for casual music 
listening and our point-and-shoot digital 
camera for fun snapshots. The only thing 
we can’t warmly praise is the W800i’s 
$499 price tag—but we think it’s worth 
the cost.—Helmut Kobler

W800i Walkman
FEATURE-PACKED MUSIC-PLAYING MOBILE PHONE

COMPANY: Sony Ericsson
CONTACT: 866-766-9374, 
www.sonyericsson.com
PRICE: $499

REQUIREMENTS: 
USB-equipped Mac

GOOD NEWS: Small, well-designed phone. Easy 
syncing with Mac data. Good battery life. 
BAD NEWS: Doesn’t play iTunes Music Store tunes. 
No bookmark feature. Pricey.

ON THE
DISC

iTuneMyWalkman 
FinderCleaner

With its great music player and 
2-megapixel camera (above), the 
W800i is everything the ROKR 
should’ve been—and then some.

TI
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     W800i UTILITIES
If your Mac freezes when you 
disconnect the W800i, run 
K750iGrabber (donationware, 
http://www-users.kawo2
.rwth-aachen.de/~razzfazz/
k750igrabber) to fi x the problem. 
If music fi les don’t play, use 
FinderCleaner (free, on the Disc, 
www.boswortels.tk) for an easy fi x. 

     W800
If your Mac freezes when you IM
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DeBabelizer Pro 6 is a comprehensive 
tool for fi le conversion, image 

editing, and media optimization. It 
supports an impressively large number 
of graphic, animation, and video formats 
and is capable of handling large media-
processing jobs. It also includes powerful 
automation features that can reduce the 
most complex conversion job to a simple 
drag-and-drop operation.

While mastering DeBabelizer’s feature 
set is a daunting task, getting started 
can be as simple as dragging fi les or 
folders onto any of DeBabelizer’s 44 
sample Droplets (AppleScripts that 
execute one or more DeBabelizer 
actions), and you can execute a Droplet 
without launching DeBabelizer. Sample 
Droplets include Convert RGB To CMYK, 
Convert CMYK To RGB With Alpha, Rotate 
Left, Rotate Right, and Trim Solid Color 
Edges. All Droplets are also available as 
Automator Actions, which means Tiger 
users can employ them (and any custom-
built Actions) in multi-app workfl ows.

Power center. If your work requires 
more than what Droplets offer, you 

can create a custom sequence of 
DeBabelizer actions called a workfl ow. 
The ability to create workfl ows and use 
them with DeBabelizer’s Batch feature 
(which lets you group fi les from multiple 
folders) is the heart of DeBabelizer’s 
power, but it’s also where things 
start to get less intuitive. The good 
news is that DeBabelizer’s interface 
is replete with context-sensitive help. 
The bad news is that if you need more 
information than the help offers, the 
PDF user’s guide provides little in the 
way of context—it’s more of a reference 
manual. The electronic help fi le, which 
ties into Apple’s anemic Help system, 
is essentially a carbon copy of the PDF 
guide. Equilibrium would do well to look 
at the robust help system for Adobe’s 
Creative Suite 2.

Speaking of stuff that needs a little 
work, the software has a few glitches. 
One simple test Droplet we created 
occasionally crashed the app, and 
when it did work, the auto-naming 
feature incorrectly produced duplicate 
fi le names. To its credit, Equilibrium 

technical support was 
very responsive and 
attributed some of the 
glitches to known issues 
with Mac OS X. The 
company also assured 
us that the problems 
would be fi xed in an 
upcoming update.

DeBabelizer Server. 
Any discussion of 
DeBabelizer Pro 6 
would be incomplete 
without mentioning 
DeBabelizer Server, a 

new product that lets DeBabelizer Pro 
6 users send their media-processing 
jobs to a server, which then delivers 
the resulting fi les to any offl ine location 
or FTP site. DeBabelizer Server also 
automatically compresses processed 
fi les and sends them to colleagues 
and clients via email. Confi guring 
DeBabelizer Server is not a simple plug-
and-play operation, but once you get 
it working, it’s a production juggernaut. 
You can set up hot folders on the 
server or create aliases of hot folders 
on client machines, and then drag and 
drop individual fi les, folders, or entire 
volumes onto a hot folder for processing 
on the server. Other features include 
the ability to create Joblets (similar 
to Droplets) for drag-and-drop server 
processing or job-status notifi cation via 
text message or email. DeBabelizer Pro 
6 includes a free 15-day trial version 
of DeBabelizer Server, so you can try it 
without shelling out any cabbage. 

The bottom line. If your image-
conversion needs are modest, you 
can probably get by with Photoshop or 
Lemkesoft’s GraphicConverter. However, 
neither of these products holds a candle 
to DeBabelizer Pro 6 when it comes to 
industrial-strength media-processing 
capabilities.—John Cruise

DeBabelizer Pro 6
MAMMOTH MEDIA-PROCESSING SOFTWARE

The ultimate tool for large 
media-processing tasks.

COMPANY: Equilibrium
CONTACT: 415-332-4343, 
www.equilibrium.com
PRICE: $399.95 (full), $199.95 (upgrade)

REQUIREMENTS: G3, Mac OS 
10.3 or later, 128MB RAM, Internet 
connection

GOOD NEWS: Extensive feature set. Many graphic 
formats supported. Powerful automation capabilities.
BAD NEWS: Learning curve is difficult. Comprehensive 
documentation is not user-friendly. Some bugs need fixing.

ON THE
DISC

DeBabelizer Pro
DeBabelizer Pro Server
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A pple added some seriously cool 
visual mojo to Mac OS 10.4 

(Tiger) with Core Image, a boatload of 
image-processing routines built into 
the operating system. Stone Design’s 
iMaginator is a simple front end to these 
effects (and even a few more), and it’s a 
nice way to see Core Image in action. But 
iMaginator’s limitations prevent it from 
becoming a serious image editor.

Getting started with iMaginator is 
as effortless as it gets—simply load 
an image (JPEG, TIFF, or PICT, though 
iMaginator surprisingly doesn’t support 
PICT for export) into the main working 
window and start playing. A nicely 
categorized list of effects appears on 
the left side of the main document 
window. We like that you can search for 
a specifi c effect by name without having 
to wade through the long list of all the 
Core Image effects—100 of ’em, which 
should keep you busy for a bit—and 

Stone Design even includes nine effects 
of their own: Polka Dots, for example, 
is a fun way to break an image up into 
colored dots; Stone’s masking plug-ins, 
on the other hand, are less impressive. 
Specifi c combinations of effects can be 
saved together as effects “chains” in the 
app’s library, allowing them to be used 
as effects macros on other images—a 
nice touch. 

Edit tools. iMaginator has basic 
tools for creating text; it also has some 
rudimentary painting tools with two 
brush shapes (square and round), 
though their performance is downright 
glacial even on our dual 2GHz Power 
Mac G5. The seemingly cool QuickTime 
animation option automatically animates 
a selected Core Image Effect and lets 
you save the results as a QuickTime 
movie, but you have no signifi cant 
control over the process; iMaginator 
decides what it will and won’t animate. 

For example, when an 
effect has multiple 
control sliders, 
iMaginator animates 
only the fi rst control 
slider and completely 
ignores the others. 
The tool ends up 
being a cute toy 
that’s completely 
meaningless when 
it comes to actual 
animation work.

Which brings 
us to our interface 
gripes: Forget about 
reordering multiple 
images in a stack, 
changing the opacity 
of a single layer, or 
applying effects to a 
single layer at a time—
an applied effect 
changes everything in 
a layered document, 
and while there are 

some lengthy workarounds, this is far 
less than stellar behavior in an app 
designed to apply fi lters to images. If this 
were version 1.0, we might understand, 
but this is 2.0. Fortunately, Stone Design 
provides free upgrades for the life of the 
company; hopefully we’ll see a more-
robust interface in the future.

You need Tiger to get the most out of 
iMaginator, but the app will still work 
if you’re using an older version of OS 
X—it’ll just work more slowly. The trick is 
that Tiger makes everything work pretty 
much in real time, although we started 
running into slowdown when more than a 
few layers and a handful of effects were 
loaded into a document. 

The bottom line. iMaginator gives 
you inexpensive access to Core Image 
routines, but there are freeware apps 
available such as LiveQuartz (www
.rhapsoft.com) that do so at no cost.
—David Biedny

iMaginator
SIMPLE IMAGE EDITOR

COMPANY: Stone Design
CONTACT: 505-345-4800, 
www.stone.com
PRICE: $49

REQUIREMENTS: 
Mac OS 10.4 or later

GOOD NEWS: Good Core Image support. Effects chaining. 
Inexpensive. Free upgrades for the life of the company.
BAD NEWS: Weak layering capabilities. Tepid QuickTime 
animation. Crippled layering interface.

iMaginator makes it easy to create cool effects, but it lacks layer-management skills.
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Canon’s Selphy CP510 printer is an 
ideal companion for any PictBridge-

compliant camera. In under a minute, 
you can have beautiful 4-by-6-inch 
borderless prints that rival those from 
commercial photofi nishers.

The CP510 prints via dye sublimation, 
a technology in which a print head 
vaporizes cyan, magenta, yellow, and 
black dye on ribbons to produce an 
image. You’ll need to leave room behind 
the CP510 for the print media to move 
back and forth as each dye color is 
used—something the manual fails to 
mention. Coated dye-sub prints can last 
as long as conventional fi lm prints and 
don’t smear when they get wet.

No fuss. The CP510 is extremely 
compact (7 by 5.2 by 2.5 inches, though 
it grows to 12.5 inches in length with the 
paper carrier installed) and weighs only 
33 ounces. Setup is easy—just plug in 
the printer, insert the included dye-sub 
ribbon cartridge, load the included fi ve 
sheets of media into a carrier, push the 
carrier into a front slot on the printer, 
and press the power button. The fi ve-
print starter kit won’t get you far—you’ll 

want to buy Canon’s 108-sheet color-
and-ink package for $29.99.

The C510 has three different USB 
attachment schemes. The fi rst is a too-
short retractable cable that plugs into 
most cameras. If yours isn’t a match, 
a standard USB-A port lets you use 
the cable that came with your camera. 
A separate USB-B port can tether the 
printer to your Mac. You also get Mac-
compatible driver software, an image 
browser, and a panorama-stitching app.

In addition to 4-by-6-inch photos and 
postcards (the back side is preprinted 

with a postcard layout so you can 
scribble a message, address it, stamp 
it, and mail it), the CP510 also prints 
3.5-by-4.7-inch and 2.1-by-3.4-inch 

credit-card-size pictures or eight-
to-a-sheet labels, all with the 

same media and the 
same supplied 

paper cassette—
even though 

the manual says 
otherwise. If you print 

4-by-8-inch panoramic 
images, you need an optional 

$19.99 tray. A $79.99 battery pack 
that snaps onto the printer is also 
available; it can print around three-
dozen 4-by-6-inch photos before it 
needs recharging.

Fast. We plugged a Canon PowerShot 
A410 (see Reviews, p52) into the printer, 
selected an image, and pressed the 
print button on the camera. Our print 
was done 58 seconds later—just like 
Canon said it would be. Of course, that’s 
what we expected when two Canon 
products interfaced—you’ll only get 
prints that quickly when using a Canon 
camera with a Digic II processor. To see 
how long it would take to print images 
from other cameras, we plugged in an 
Olympus Evolt E-300 (  May/04, 
p41), selected its PictBridge mode in 
the menu, chose a picture, and issued 
the print command. It took 42 seconds 
longer, but it worked without a hitch. 
Ditto for a Pentax *istDS.

As for the image quality—did you not 
catch the “prints that rival commercial 
photofi nishers” statement at the 
beginning of this review? The CP510 
yields accurate, vibrant colors and 
excellent detail.

The bottom line. If you’re looking 
for an inexpensive printer that quickly 
outputs small-size, high-quality photos 
on the cheap, the CP510 is the way to 
go.—Arthur Bleich

COMPANY: Canon
CONTACT: 800-652-2666, 
www.canonusa.com

PRICE: $99
REQUIREMENTS: USB-equipped 
Mac, Mac OS 10.2 or later

GOOD NEWS: Affordable. Fast setup. Works perfectly 
right out of the box. Excellent print quality.
BAD NEWS: Comes with a measly five sheets of paper. 
Short built-in camera cord.

If you get this 
printer, you’ll need 
to fi nd a new way to 
keep in touch with 
your commercial 
photofi nisher.

     PREP YOUR CAMERA 
FOR PRETTY PRINTS
To get top-notch image quality for 
printed photos, you need to start 
at your camera. Ditch its bundled 
memory card and get one with 
a larger capacity. You’ll need it, 
because high image quality means 
large fi le sizes. If your camera 
offers you a choice of fi le formats, 
don’t pick JPEG—instead, pick TIFF 
or RAW. Your fi les will be large, 
which is why you’ll need a more-
capacious memory card.

     PREP YOUR CAMERA 
FOR PRETTY PRINTS

Selphy CP510
SUBLIME PHOTO PRINTER

TI
P
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Mercury Elite-AL PRO 800 RAID
SPEEDY AND SOLID RAID ARRAY

With hard drives getting less 
expensive every day and your 

video, audio, and image collections 
steadily growing, it may be time to 
consider an entry-level RAID array such 
as the Mercury Elite-AL PRO 800 RAID. 
You can get a 160GB setup for a mere 
$239.99 or max out at 1TB for $949.99. 
If you edit media, you’ll defi nitely 
appreciate the speed benefi ts of this 
out-of-the-box RAID 0 system (you can 
also switch to RAID 1 with a fi rmware 
upgrade from OWC’s Web site).

The Mercury Elite isn’t the only RAID 
array that has an industrial-strength 
aluminum case that looks similar to 
the Power Mac G5—there’s also Huge 
Systems’ MediaVault U320-R (  
Dec/04), though Huge’s RAID 0/3 array 

has higher-end customers 
in mind than the RAID 0/1  
Elite. The Elite comes with 
two FireWire 800 ports and 
one FireWire 400 port. A 
pair of 7,200-rpm Seagate 
Barracuda hard drives (each 
with an 8MB buffer) lie 
under the hood.

We tested the $599.99 
800GB model using Xbench 
(free, www.xbench.com), 
a popular benchmarking 
utility, on a dual 2.7GHz 
Power Mac G5. Over FireWire 800, the 
Mercury Elite posted sequential 256KB 
uncached-write data-transfer speeds 
of around 50 MBps—pretty decent, 
and just a tad slower than the 55-MBps 

speed posted by 
the Power Mac’s 
internal 250GB 
Maxtor Serial ATA 
drive. But in the 
sequential 256KB 
uncached-read 
data-transfer test, 
the Mercury Elite 
posted a speed of 
81 MBps—much 
faster than the 55 
MBps of the Mac’s 
internal drive.

The bottom line. If you’re working with 
large fi les, using a RAID 0 array such 
as the Mercury Elite can help you work  
effi ciently—and it looks stylish next to 
your Power Mac G5.—Roman Loyola

COMPANY: Other World Computing
CONTACT: 800-275-4576, 
http://eshop.macsales.com

PRICE: $239.99 (160GB) to $949.99 (1TB)
REQUIREMENTS: Mac OS 8.6 to 9.x or 10.1 
or later, Mac OS 10.2 or later for FireWire 800

GOOD NEWS: Fast FireWire 800 support. 
Looks good. Well built.
BAD NEWS: Firmware change required
to switch from RAID 0 to RAID 1.

No cheese-
grater jokes, 
please—this drive 
is built for speed.

inMotion iM7
TERRIFIC iPOD SPEAKER STAND

The inMotion iM7 is one of the best 
iPod speaker stands we’ve seen. It’s 

attractive, sounds great, boasts a super 
set of features—and has only a few minor 
annoying quirks.

The 16.5-by-6.5-by-6.5-inch iM7 
houses a pair of one-inch tweeters, two 
three-inch midrange drivers, and a four-
inch subwoofer that blasts bass out the 
left side. All the components combine to 
produce some of the best sound quality 
we’ve heard from iPod speakers—full, 
booming bass; clean mids; and crisp 
highs. It has no problem loudly fi lling a 
room, and we didn’t notice any distortion 
at high volumes.

The iM7’s dock opens and closes to 
securely hold your compatible iPod (you 
can put a iPod nano inside, though it 
looks odd), and it comes with a short-

range (about 
15 feet) remote 
control that 
handles a limited 
number of iPod 
functions—you’ll 
need to get up off 
your butt and use 
the iPod’s controls to 
access playlists, change EQ settings, 
and fi ddle with other deep-access 
options. Also, the iM7’s volume, bass, 
and treble controls don’t provide any 
visual feedback, so you’ll sometimes 
fi nd yourself button-mashing the 
remote, missing the setting you want.

The iM7’s rear has S-Video and 
composite-video ports so you can play 
slide shows from your iPod photo and 
videos from your video-capable ’Pod, 

a headphone jack (which we wish was 
on the front), and an auxiliary port for 
connecting other audio devices. The 
ports lie beneath the iM7’s handle, 
which you shouldn’t use if you need to 
haul the iM7 long distances—it’s too 
uncomfortable. The iM7 draws its power 
from an included universal adapter or 
eight D batteries, which lasted 10 hours, 
6 minutes in our testing.

The bottom line. Even with the iM7’s 
shortcomings, the sound it produces is 
just too good to pass up.—Roman Loyola

COMPANY: Altec Lansing
CONTACT: 570-296-6887, 
www.alteclansing.com
PRICE: $249.95

REQUIREMENTS: Third-, fourth-, or 
fifth-generation iPod, iPod mini, iPod 
nano, or iPod photo 

GOOD NEWS: Stylish. Excellent sound. Universal power 
adapter. Can use batteries.
BAD NEWS: Short remote range. No indicators for controls. 
Uncomfortable handle.

Dude! The iM7 is 
totally tubular!
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You’ll almost hear the “POW!” 
coming right off the page. 

For many of us, life seems to imitate 
art, so wouldn’t it be cool to meld 

the two? With Comic Life Deluxe Edition, 
you can transform your personal photos 
into colorful comics—and it’s fun, easy, 
and extremely addicting.

You start building your comic by  
laying out panels to hold photos or 

simply picking from the 322(!) included 
templates, which range from traditional  
grids to more-conceptual constructs, 
such as heart and fi sh shapes. Panel 
attributes (and attributes for all other 

elements in a comic, 
for that matter) can 
be changed to spiff 
things up—you get to 

adjust colors, drop shadows, borders, 
and the overall shape of your comic.

Once you set the framework, it’s time 
to import your photos. Just drag and 
drop pics from Comic Life’s fi le browser, 
located at the bottom-right corner of 
the app’s main window—navigate to the 
appropriate location on your hard drive, 
or dive into your iPhoto Library with one 
click of a button. If you have a video 
camera such as an iSight or DV cam, 
Comic Life can capture images directly 
from it. After you place a photo in the 
appropriate panel, you can move the 
pic around or zoom. You can even add 
some visual punch by applying one of 17 
image fi lters. Want an authentic comic 
look? Choose Comicify. Feel like going 
psychedelic? Select Pop Art ’05. It’s fun 
to experiment, but fi lters only work in 
Mac OS 10.4 (Tiger).

The story. 
Our favorite 
step comes 

next: adding dialog 
balloons, captions, and 
lettering to tie everything 
together. Comic Life 
comes with 12 varieties 
of dialog balloons to 
drop into your comic 
pages, including a 
dotted oval for whispers 
and a cloud shape for 
conveying thoughts. 
Movable balloon tails 
make it easy to connect 
balloons to the proper 
subjects, and you can 
extend a balloon or 
attach an additional 
balloon to a pre-existing 
one—great when you 
want to lengthen a 
conversation within a 
single panel. Playing 
around with lettering 
is fun, too, as you can 
stretch, warp, and rotate 
words to your heart’s 

content. Done right, you’ll almost hear 
the “POW!” coming right off the page.

For the masses. When your comic 
is ready, the only thing left to do is 
publish it—you can print it out, save 
it as an image, create a QuickTime 
movie (just a video slide show of all 
your comic pages), export it to HTML 
so you can put it on the Web, or send 
it straight to your .Mac account. If 
you plan to publish regularly on .Mac, 
Comic Life gives you convenient access 
to sort comics, delete older ones, and 
rename your home page.

The bottom line. Comic Life is a 
remarkable app, and we love it. You can 
save $5 and buy the standard edition 
directly from the developer, Plasq (www
.plasq.com), but you get fewer fonts, 
styles, and templates. Splurge—get the 
Deluxe Edition.—Gil Loyola

Comic Life Deluxe Edition
FUN-AND-EASY COMIC-CONSTRUCTION SOFTWARE

Comic Life provides the easy-to-use tools; you provide the creativity.

COMPANY: Freeverse
CONTACT: 212-929-3549, 
www.freeverse.com
PRICE: $29.95

REQUIREMENTS: Mac OS 10.3 or 
later (Mac OS 10.4 or later for photo 
filtering)

GOOD NEWS: Easy to use. Fun, fun, fun!
BAD NEWS: Image filters require Mac OS 10.4 (Tiger).

ON THE
DISC

Comic Life
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Canon’s 3.2-megapixel PowerShot 
A410 is like a magician’s hat—just 

when you think there can’t possibly be 
anything left in it, out pops a rabbit. No, 
silly, rabbits don’t actually pop out of 
the A410—we’re making an analogy: The 
A410 is a great point-and-shoot camera 
that will surprise you with its unusual 
visual tricks.

on a 35mm camera) telescopes out in 
less than a second after you press the 
power button. With a large maximum 
aperture of f/2.8 (at full wide angle), you 
can capture images in most low-light 
situations without the fl ash. But when 
the fl ash is needed, it takes a full fi ve 
seconds to recycle between shots, and 
its reach is only about 10 feet. 

per second and keep on clickin’ until it 
runs out of memory-card space—and 
that’s going to happen in a wink with the 
wimpy 16MB MultiMediaCard that Canon 
supplies. We used a 128MB SanDisk 
Ultra II SD (interchangeable with an 
MMC) that gave us 74 high-resolution 
images instead of the eight we could fi t 
on the bundled card.

The A410’s Achilles’ heel is that 
its slowest shutter speed is only one 
second; there’s no bulb setting that 
allows for longer exposures. Some 
low-light night scenes we shot were 
underexposed. On the up side, there’s 
a fast 1/2000-second setting to 
freeze action, which is more relevant 
to everyday shooting. There are also 
eight scene modes (including Portrait, 
Landscape, and Action), a setting for 
panoramas, and a supermacro mode for 
taking close-up shots up to a half-inch 
from your subject. 

Tricks. And then there are those 
extra tricks we mentioned earlier. Photo 
Effects can make pictures more vivid, 
desaturate them, capture them in sepia 
or black-and-white, or just soften the 
outlines. My Color settings push the 
envelope further by allowing you to swap 
one color for another or drop out every 
color except the one you choose for a 
neat color-accent image. It can even save 
both the full-color image and the one 
you’ve chosen to accent. 

Once we had worthwhile shots, we 
rolled out some impressive 11-by-14-
inch prints on an Epson Stylus Photo 
2200. We then connected the camera 
to the $99 Canon Selphy CP510 printer 
(see Reviews, p48), selected an image to 
output, pressed the A410’s Print/Share 
button, and in less than a minute had a 
beautiful 4-by-6-inch borderless photo. 

The bottom line. The A410 is a great 
entry-level or second camera with 
excellent color, sharp defi nition, and low 
noise. Best of all, it has some unique 
features that’ll let you perform some 
great visual magic.—Arthur Bleich

PowerShot A410
SERENDIPITOUS POINT-AND-SHOOT CAMERA

COMPANY: Canon
CONTACT: 800-652-2666, 
www.canonusa.com
PRICE: $149.95

REQUIREMENTS: USB-equipped 
Mac, Mac OS 8.6 to 9.x or 10.1 or later

GOOD NEWS: Feature-rich without being overwhelming. 
Fast. Fine picture quality. Cool photo effects.
BAD NEWS: No video out. Jerky movies without sound. Flash 
has long cycle time. Bundled with wimpy 16MB memory card.

It looks like a simple point-and-shoot camera, but Canon’s PowerShot A410 has a few tricks 
up its sleeve.

Ergonomically, the A410 is just the 
right size: not a teeny-weenie boutiquer 
that cries out for baby fi ngers, and not a 
big, clumsy brick. The optical viewfi nder 
is a great alternative to the 1.5-inch LCD, 
which can vanish in bright sunlight. 

The A410’s 3.2X optical-zoom lens 
(the equivalent of 41mm to 131mm 

Little lag. There’s practically no 
delay (shutter lag) between when the 
moment you press the shutter button 
and when the picture is actually taken. 
You can take your next picture in about 
a second—fast for a point-and-shoot. 
When set to continuous mode, the 
camera can blaze along at 2.5 frames 

Dropping out all the colors except the one you choose to keep (in this case, yellow) is one of 
the A410’s many creative features. 



54 REVIEWS
better living through smarter shopping

   February 200654

In the beginning, a weird book 
fell through a rip in the sky and 

transported us to a mysterious island 
fi lled with abstract puzzle after abstract 
puzzle—that’s how millions of gamers 
fell in love with (and plenty of others 
learned to loathe) the puzzle-laden 
world of Myst over a dozen years ago. For 
fans of the series, Myst V: End of Ages 
ends the saga triumphantly, but if you’ve 
ever tried and hated a Myst game before, 
you’ll fi nd nothing here to make you 
want to open this book again.

Myst V begins with a voiceover by 
Atrus that introduces you to the story, 
offering newbies a crash course in 
Myst-tory. As you play, two other people 
emerge as central fi gures in your quest: 
Yeesha, the daughter of Atrus and 
heroine of previous games, who urges 
you to release a great Tablet to renew 
the D’ni culture; and a new guy named 
Esher, who has other ideas about how 
you should use the powers of the Tablet. 
You go through seven Ages, each with 
its own distinctly awesome visual theme 
and fi endishly abstract puzzles, trying 
to unlock the Tablet’s secrets and decide 
whom to trust.

You move around the world in three 
different ways: Classic Myst mode 
offers the familiar point-and-click style; 

Classic Plus mode unlocks the pointer 
from the center to view and interact with 
objects; and a new Free-Move mode (our 
favorite) uses the keyboard to move and 
the mouse to guide you, like in a fi rst-
person shooter—you can’t, however, 
invert the mouse. 

Myst V’s puzzles can be 
mind-blowingly diffi cult, and 
they often require you to 
communicate (through 
written symbols scrawled 
with your mouse) with 
another species called the 
Bahro, whose powers can 
do things like melt snow 
to create steam to power a 
machine, or mystically turn 
the refl ection in a puddle 
into a writing decoder. 
Using the mouse as a 
stylus can be tricky, but 
luckily the Bahro can read 
handwriting with more 
accuracy than the Newton 
ever could. A personal 
log helps you remember 
the symbols you encounter, and you 
can even store notes and pictures of 
locations—very useful. 

The Limited Edition is the only way 
Mac addicts can get their Myst fi x—the 

standard edition is for peecees only—but 
it’s completely worth the extra ten bucks. 
The set contains the game on a single 
hybrid DVD, a game-soundtrack CD, a 
(rather short) DVD on the history and 
making of the game, an offi cial strategy 
guide, developer interviews, a Myst 

timeline, concept sketches, and an 
individually numbered collector’s 

lithograph. The strategy guide 
is an especially worthwhile 

goodie, as the well-written 
walkthrough gives you just 
enough help to complete 
the game without solving 
it for you outright—and 
the lithograph isn’t just a 

screen shot from the game, 
but a stained-glass-style 

D’ni illustration. Nice stuff.
The bottom line. If you’ve 

hated Myst from day one, 
End of Ages probably 
won’t change your mind. If 
you’ve followed Myst and 
enjoyed the ride, then you 
simply have to get this fi nal 

installment. And if you’ve never played 
a Myst game, you don’t need to know 
the complete back story to enjoy End of 
Ages—just don’t expect any nostalgic 
chills.—Matt Osborn

Myst V: End of Ages Limited Edition
LEGENDARY GRAPHIC-ADVENTURE GAME

COMPANY: Ubisoft
CONTACT: 415-547-4000, 
www.ubi.com
PRICE: $59.99

REQUIREMENTS: 1GHz G4, Mac 
OS 10.2.8 or later, 256MB RAM, 32MB 
ATI Radeon 9600 or nVidia FX 5700 or 
better, 4.1GB disk space

GOOD NEWS: Awesome 3D environments and graphics. 
Great puzzles.
BAD NEWS: Some puzzles are too hard. This game marks 
the end of the saga.

David Ogden Stiers (aka 
Major Winchester from 
the TV show M*A*S*H) 
provides the voice of Esher.

Some puzzles are as complicated as 
they look—and even those that don’t 
look complicated usually are.
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ACCESSORIES   

Epson P-2000 $499.99 Aug/05, p46 This media player’s gorgeous display is a photographer’s dream.

Palm Treo 650 $659.00 May/05, p44 It’s the best PDA-and-cell-phone combination on the market.

AUDIO & VIDEO   
iHome iH5 $99.95 Jan/06, p57 This great-sounding clock radio includes a dock for your iPod. 

Mitsubishi HC100U $1,495.00 Aug/05, p52 This projector/screen combo is the perfect home-theater pair.

Sonos Digital Music System $1,199.00 Jun/05, p36 Pricey, yes—but it’s the best music streamer you can buy.

DIGITAL CAMERAS   
Canon EOS Digital Rebel XT $999.00 Sep/05, p44 A compelling reason to switch from your old point-and-shoot.

Canon PowerShot A85 $299.99 Mar/05, p40 This 4-megapixel point-and-shoot beauty takes great pictures.

Nikon D70 Digital SLR $1,299.00 Jul/04, p50 It’s as close to perfect as any digital SLR camera we’ve seen.

PRINTERS   
Brother International HL-2070N $169.99 Sep/05, p53 This affordable laser printer is great for text, charts, and graphs.

Canon Pixma MP780 $249.00 Dec/05, p48 Scan, fax, and print both business docs and photos beautifully.

Epson Stylus Photo R1800 $549.00 Sep/05, p43 If you’re a serious photog, this midrange inkjet is a bargain.

Epson Stylus Photo R2400 $849.99 Dec/05, p44 The successor to Epson’s great Stylus Photo 2200 is even better.

Konica Minolta magicolor 2430 DL $499.00 Oct/05, p44 Want fast photo-quality laser images at a good price? Here y’go.

STORAGE   
ILY SlimDVDup $699.00 Apr/05, p45 Quickly duplicate CDs and DVDs without tying up your Mac.

LaCie d2 DVD±RW Double Layer $129.00 Feb/05, p48 Cram 8.5GB of data onto DVDs with this speedy burner.

Newer Technology miniStack 400GB $349.99 Nov/05, p42 This speedy Mac mini–style drive is also a FireWire and USB hub.

OWC Mercury Elite-AL Pro 400GB $359.99 Nov/05, p50 Speed, a great case, FireWire 800/400, and USB 2.0—good stuff.

Sony DRX-710UL/T $229.95 Jun/05, p46 This double-layer burner has scorching single-layer performance.

WiebeTech TrayDock $169.95 May/05, p49 This slick hard-drive enclosure provides the ultimate in fl exibility.

AUDIO   

Apple Soundtrack Pro $299.00 Sep/05, p40 This is one of our favorite components in the Final Cut Studio suite.

Arturia ARP2600 V $310.00 Nov/05, p52 The legendary analog synth is back, now digital and polyphonic.

Bias SoundSoap 2 $99.00 Jul/05, p37 SoundSoap Pro’s little brother is a capable audio cleaner.

Native Instruments Absynth 3 $339.00 Sep/05, p45 This surreal electronic synth has great surround-sound support.

Native Instruments Kontakt 2 $449.00 Jan/06, p43 Native Instruments scores again with this superb software sampler.

GAMES 
Aspyr Doom 3 $49.99 Jun/05, p48 Hellish, scary fun—but not for the faint of hardware.

Aspyr The Sims 2 $49.99 Oct/05, p36 The sequel to the megapopular simulation is loaded with new goodies.

Aspyr Tiger Woods PGA Tour 2005 $39.95 Jan/06, p46 Not just a great golf game, but a great game, period.

Blizzard World of Warcraft $49.99 Apr/05, p40 This rich online role-playing game is more addictive than nicotine.

MacSoft Close Combat: First to Fight $39.99 Sep/05, p38 One of the most intense squad-based tactical shooters around.

GRAPHICS & LAYOUT   
Adobe InCopy CS2 $249.00 Aug/05, p42 This workfl ow app amps up any InDesign team’s productivity.

Adobe InDesign CS2 $699.00 Aug/05, p40 A strong upgrade to the world’s most feature-rich layout app.

Adobe Photoshop CS2 $649.00 Aug/05, p38 A raft of new photo-focused features makes this upgrade rock.

Adobe Photoshop Elements 3.0 $89.99 Mar/05, p36 Adobe’s affordable image editor gets a signifi cant upgrade.

Corel Painter IX $429.00 Feb/05, p38 This natural-media champ is now faster and more capable. 

Macromedia Dreamweaver 8 $399.00 Dec/05, p42 The best Web-authoring tool you can buy, be you pro or newbie.

PixelGenius PhotoKit $49.95 Nov/05, p48 A great photo-fi xer, especially if you shoot in black and white.

PixelGenius PhotoKit Color $99.95 Dec/05, p52 Take your color photos to new heights with this pro plug-in pack.

PRODUCTIVITY & UTILITIES   
Bare Bones Software BBEdit 8.0 $199.00 Jan/05, p36 By far the most powerful text editor money can buy.

Microsoft Offi ce 2004 $399.00 Aug/04, p42 Enhancements to every app add up to a worthy upgrade.

VIDEO & ANIMATION   
Apple Final Cut Express HD $299.00 Jul/05, p32 This low-cost editor adds HDV support, Soundtrack, and LiveType.

Apple Final Cut Pro 5 $999.00 Sep/05, p36 If you want to work with HD or multicamera editing, get this now.

Macromedia Flash Professional 8 $699.00 Jan/06, p42 Media designers should run, not walk, to get this potent update.

 

the List SHOPPIN¬?HERE’S WHAT WE RECOMMENDHot
THE BEST OF THE BEST FROM RECENT REVIEWS

Kontakt 2
Pro musician David Biedny calls this 
app “the most awesome and complete 
software sampler we’ve ever seen.”

Tiger 
Woods 
PGA Tour 
2005
MacAddict Reviews Editor and dedicated 
duffer Roman Loyola says that the latest 
Tiger “is a game every golfer should have.”

Flash 
Professional 8
According to veteran designer 
Nathan Moody, “Flash is the best 
cross-platform, cross-browser, 
rich-media-delivery platform 
on the planet.” 

iH5
Gadget goddess 
Cathy Lu says, 
“We dig the iH5.”
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supports OS X’s iSync for easy syncing of 
contacts, calendars, and notes.

TOASTY DVDS
Can I make audio DVDs in iTunes?
Nope. Technically speaking, an audio 
DVD is just like an audio CD, only longer: 

It can play on 
your Mac, in your 
car, or in almost 
any component 

because inquiring minds have the right to be inspired

DVD player. iTunes can burn audio CDs, 
but not audio DVDs; try Toast 7 Titanium 
($79, www.roxio.com), which can burn 
audio DVDs from your iTunes library or 
from song fi les you drag into the app.

PASSWORD PROTECTION
I have over 100 passwords stored in 
my Keychain—some of which are for 
Web-site logins. Can I print up a list of 
passwords to take with me?
That wouldn’t be very secure, now would 
it? Apparently Apple doesn’t think so 
either, because there’s no way to do 
it. If you forget a password, you can 

iCHAT, U(SB) CHAT
I have an old USB Webcam. Can I use 
it with iChat AV to videoconference?
iChat AV supports pretty much any 
FireWire video camera you can plug 
into a Mac, which is slick—unless 
your Webcam works over USB. For the 

USB-cam crowd, Ecamm Networks’ 
iChatUSBCam ($10, on the Disc, www
.ecamm.com/mac/ichatusbcam) is 
the ticket, though the quality isn’t as 
good as a fast FireWire camera. Plus, 
iChatUSBCam only works if you already 

have driver software for your camera 
installed. If you have a USB cam but 
no driver, try IOExperts’ IOXWebcam X 
($19.95, on the Disc, www.ioexperts
.com) or, if you’ve got more chutzpah 
than cash, try the open-source macam 
(free, on the Disc, http://webcam-osx

.sourceforge.net), 
which supports tons 
of USB cameras— 
including ones we’ve 
never even heard of.

SQUIRRELY MOUSY
I have a weird problem: Whenever I click 
a fi le on my desktop, I get a little box 
offering different options such as Open 
or Move To Trash. What gives?
Sounds like a problem with your mouse 
or its driver software. What’s happening 
is that you are invoking Contextual 
Menus, whether you want to or not. 
Normally, you invoke a Contextual Menu 
by right-clicking or clicking an item 
while holding the Control key. In your 
case, fi rst check your mouse’s settings 
in System Preferences > Keyboard & 
Mouse or in your mouse manufacturer’s 
proprietary preference pane; you can 
designate a left or right click as your 
Primary Mouse Button; the other button 

will summon the Contextual Menu. If all’s 
well, check with the manufacturer to see 
if the mouse’s driver has been updated—
and make sure you’re not accidentally 
pressing the Control key with your elbow.

SOUND ADVICE
My new iMac has gone mute. It doesn’t 
even make that bwong noise at startup.
First, double-check your settings 
in System Preferences > Sound. The 
iMac’s audio-out port does double 
duty, providing line or digital-audio out, 
depending on what kind of speakers 
you have attached. If you don’t have 
any attached speakers, the iMac uses 
its internal speakers. If you use external 
speakers, double-check that they’re 
correctly connected and powered up. 
The last resort is resetting your iMac’s 
PRAM (parameter RAM), which stores 
various low-level settings such as video 
and audio output. To clear your PRAM 
and restore the Mac’s default settings, 
restart while holding down Command-
Option-P-R (all together) until you hear 
the startup sound chime. Keep holding 
the keys down until you hear the chime 
a second time—you’ll then need to 
reset some display, video, time zone, 
and possibly a few other system-level 
settings (such as your startup disk).

MAIL MADNESS
How on earth do I set my default email 
application in Mac OS 10.4 (Tiger)? 
I don’t want to use Apple’s Mail!
In Mac OS 10.3 and 10.4, your default-
email-client setting actually lives in Mail’s 
Preferences. You read that right—you 
need to open Mail (/Applications/Mail) in 

BERRY GOODS
Can I use a BlackBerry PDA with my Mac?
Yes, but you’ll need to purchase Pocket 
Mac for BlackBerry ($30, on the Disc, 

www.pocketmac
.net/products/
pmblackberry). This 
slick connection kit 

Psst. I’ve got some USB video chat for ya.

  February 200656

Keep this in mind next April Fools’ Day.

Toast ties directly 
into iTunes for 
seamless burning.

ON THE
DISC

iChatUSBCam
IOXWebcam X
macam

ON THE
DISC

Pocket Mac for 
BlackBerry
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HOW TO 57No whining—
anyone 
can do this!

It’ll take some 
effort, but you 
can do it.

This stuff’s 
for the pros.

DIFFICULTY
RATINGS 

    retrieve it by launching Keychain Access 
(/Applications/Utilities) and double-
clicking the title of the password you 
want to retrieve. In the resulting window, 
check the box next to Show Password, 
and supply an administrator-account 
password to see the password you forgot.

JUST IN CASE
I need to look inside a font suitcase 
from my old Mac OS 9 system to extract 
a particular font—how can I open a font 
suitcase in Mac OS X?
We’ve got just the ticket: FontThing ($10, 
on the Disc, www.pidog.com/fontthing). 

Submit technical questions 
or helpful tips directly 

via email (askus@macaddict.com) or c/o 
MacAddict, 4000 Shoreline Court., Ste. 
400, South San Francisco, CA 94080.

some games—we found loads at www
.whatisthe2gs.apple2.org.za (but again, 
remember that you need to own copies 
of them to be able to legally use them). 
Follow KEGS-OSX’s instructions to install 
and play ’em.

You can use this handy little utility as 
a font manager to preview, activate, 
or deactive fonts; 
it also can open 
your OS 9–era font 
suitcases.

order to tell your Mac that you don’t want 
to use it. The real rub is that you have to 
waste a few minutes entering account 
information before you can access Mail’s 
preferences—valid information, no less, 
as Mail will contact the servers to verify 
your info before it lets you proceed. (Tip: If 
you unplug your network connection fi rst, 

Mail lets you slide on the verifi cation). 
After you feed Mail an account name, 
password, and server addresses, the 
New Account assistant appears to help 
you Create Another Account or Import 
Mailboxes—at this point, you can 
fi nally access Mail’s preferences (Mail > 
Preferences). Click the General tab, and 
use the Default Email Reader pull-down 
menu to choose a new default email app.

II EMU
I used to play an old Apple IIGS game 
that has no Mac OS X equivalent. How 
can I run it on my new iMac?
Believe it or not, you can play old games 
like Teenage Queen and Vegas Gambler 
on a modern Mac running OS X—all via 
emulation software that creates a virtual 
IIGS within OS X. That’s the easy part; 

what you really need is the legal right 
to use the IIGS software, which means 
you should own a IIGS (originally $1,498 
with an RGB display or $999 without; 
currently $10 to $50 on eBay). If you 
don’t own a IIGS, you’re technically not 
allowed to use the ROM fi le that makes 
emulation on a newer Mac possible. 
With that out of the way, go download 
KEGS-OSX (free, www.casags.net) and 
follow the directions in the read-me fi le 
to install the emulator, and add your 
IIGS ROM fi le to enable it. Now go get 

Need to open and look inside those old 
font suitcases? FontThing’s the thing.

Mail won’t let you break it off with a simple 
Dear John letter.

Party like it’s 1989—IIGS style!

UNIX UNIVERSITY

Buz Zoller is a graphic designer living in 
Florida. He has been a devoted Mac 

user for over 10 years and has worked for 
both Apple and Power Computing.

WORD PLAY, UNIX STYLE
I can’t legally use the ROM fi les to emulate an Apple IIGS and 
play old games (see “II Emu,” below). Got a consolation prize for me?
You bet. Unix is full of fun, retro 
games—and as with most things Unix, 
the fi rst step is to launch the Terminal 
(/Applications/Utilities). To start the 
fun, type emacs -batch -l dunnet 
and press Return. This will enter you 
into a hidden text-adventure game 
built into the emacs text editor. When 
the game starts, you will see some text 
describing a location. You enter simple 
commands to explore and play the 
game. For example, type get shovel 

and press Return to get on your way. Type 
help and press Return at any time for 
some pointers.

Better yet, one of the all-time kings of 
text-only adventure gaming, Zork, has 
been rediscovered and is now playable 
on Mac OS X. But the catch—you guessed 
it—is that you have to use the Terminal 
and Unix. Rob Griffi ths of Mac OS X Hints 
(www.macosxhints.com) has compiled 
Zork and its two sequels and made the 
whole series available for free at http://

homepage.mac.com/rgriff/
zork.html. You can also 
download the instructions 
you need to get your text 
game on. Thanks, Rob!

Text-only gaming is 
just a few words away.

ON THE
DISC

FontThing
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Hack Your Toys
by Niko Coucouvanis

D
id the holidays leave you with another case of 
fruitcake-induced indigestion and a pile of dumb 
toys somebody mistakenly thought you’d like? Or are 
you still scrambling to create some unique, heartfelt 

(and belated) homemade gifts for the folks back in Fargo? 
Good: Here’s how to turn a USB fl ash drive into a fun-fi lled 
action fi gure and transform your leftover one-button mouse 
into a rubber rat. Mind you, these are just the toys we had lying 
around—a Barbie doll or rubber chicken would probably work 
just as well. 

Make sure to leave the drive 
exposed enough that you can use 
its USB connector.

2 Amateur Chiropractic
Now give the head the same treatment—bore it out until 
you can insert the drive (be careful not to go too far, or 

you’ll probably need extra tape). Make sure to seat the USB drive 
at the right depth in the doll’s head so that the drive and its cap 
fi t together securely—that way, your new storage buddy won’t 
lose his head. If either piece feels loose in the doll, remove it and 
apply liberal amounts of glue (we prefer to use a hot-glue gun). 
Let the glue set for fi ve to 10 minutes, and then place the USB 
drive pieces in their respective body parts. Gently put the head/

drive on the body/cap, and tweak 
the cap and/or drive placement 
until the head and neck fi t 
together somewhat naturally—
just don’t push too hard until the 
glue dries.

WHAT YOU NEED

Action figure

Rubber rat

USB thumb drive

Apple Pro Mouse

Strong adhesive*

Sharp knife or X-Acto blade

Quick-dry modeling clay

Pencil with eraser

*hot-glue gun, spray mount, duct tape, or rubber cement

Part 1: Doll Up Your USB Drive

1 Off with His Head
USB fl ash drives are everywhere, and we can think of 
plenty of places to cram them. But in the interests of 

family fun and entertainment, we’ll just show you how to rip off 
an action fi gure’s head and stuff the drive down his neck. First, 
pop off the head, and bore the inside of the body with an X-Acto 
blade or sharp pocketknife until the cap of the USB drive fi ts 
snugly inside—be careful not to dig too deep. Now insert the 
cap of the USB drive into body of the doll—if your doll is hollow, 

wrap duct tape around 
the cap to make it fi t. 
If you’d rather put the 
drive’s cap in the doll’s 
head, feel free to do 
so—just reverse these 
instructions.

 Steady now…

He used to be 
dumb as a foxhole, 
but now our hero 
has a mind like a 
steel trap.
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ADVANCED HACKERY:  
PLUG RELOCATION
When stuffing computer peripherals into toys, you may need 
to route a cable through an opening that’s smaller than the 
cable’s plug. The neatest way to accomplish this is to sever 
and then rebuild the cable. Cut the plug end off of the cable, 
run the cable where you want it, and then splice its wires 
back together, hiding the splice inside the vessel. You could 
also go all out and carefully remove the plug from the cable, 
snake the cable where you want it, and solder the plug back 
on—obviously, take extra care to note which wire goes where 
in the plug assembly. If you’re splicing wires, you can just 
match up the colors.

Part 2: Make Your Mouse a Mighty Rodent

1 Flay the Prey
Now that Santa brought you a real (multibutton) mouse, 
you can turn your old Apple Pro jobbie into the rat that it 

is. This hack works on most any mouse—if you’re using a non-
Apple mouse, you’ll usually find screws under the footpads on 
the bottom; remove them to open the mouse. 

On the Apple Pro Mouse, wedge a screwdriver or other stiff, 
slim tool into the seam where the flat white bottom sled meets 
the clear-plastic upper piece, and pry the mouse apart. Don’t 
worry about breaking the top pieces—it’s the bottom flat piece 
you want, as it contains the important bits (the USB cord, 
button switch, optical sensor, and lens). Keep in mind that the 

lens is usually attached to the 
bottom sled rather than to the 
circuit board, and the lens needs 
to be positioned just so relative 
to the sensor, or the mouse won’t 
function.

Unless you need a new soap dish, 
don’t worry about thrashing the 
upper pieces.

2 Slap It on the Sled
Since we found the perfectly sized and shaped rat—her 
feet are far enough apart to straddle the mouse sled, and 

her belly hangs all the way to the ground to accommodate most 
of the mouse’s original hardware—all we had to do is cut out the 

belly to make room for the 
sled and its electronics. The 
rat’s belly is expendable 
here, so start your hole 
small—it’s much easier to 
cut plastic away than it is to 
put it back. You still need to 
access the rat’s insides, so 
don’t glue anything yet.

No actual rats were harmed  
in the hacking of this mouse.

Now comes the trickiest part: extending the delicate 
button switch on the circuit board so that you can trigger 

it by pressing the top of the rat’s back. To accomplish this feat, 
you’ll be gluing a pencil inside the rat, positioned so that pressing 
on the rat’s back triggers the mouse-button switch below.

Use your X-Acto to cut a nickel-size hole in the rat’s back 
directly above the circuit board’s button switch. (You’ll reattach 
this piece as the button, so cut carefully, and don’t lose the 
piece.) Now grab a pencil, poke the eraser end into the button 
hole you just cut, and click the switch a few times to get a feel 
for it. Now rest the pencil on the switch, and—making sure the 

switch is not pressed—mark 
the pencil at the point where it 
comes out the rat’s back. Cut 
the pencil to that length.

3 Build the Button

If this part’s too tricky, you can 
cut a smaller hole and just let 
the pencil stick up through it.

Now glue the pencil to the underside of the button piece 
you cut from the rat’s back. Let it dry completely. With 

the pencil attached, put the piece you cut out back into the 
hole, and flip the rat onto its back. Tape the button piece back 
where it was before you cut it out, using copious amounts of 
duct tape on the inside of the rat to secure it in place. Remember 
the button has to trigger the switch, so precision is key. Finally, 

glue the rat’s body to 
the mouse sled, taking 
extra care to keep the 
pencil/button rig aligned 
correctly. Now that’s one 
righteous rat!

4 Seal the Deal

If the pencil doesn’t hit the 
switch, convince it with 
some more duct tape.

Upgraded to a multibutton mouse? There’s still a use for your old 
Apple Pro Mouse after all: edutainment!



Connect Directly1 If you plug your DSL or cable modem directly into your 
Mac, you set everything up in Mac OS X’s System 

Preferences. Select System Preferences from the Apple menu, 
and click Sharing; in the Services pane, decide how you’d like 
to access your Mac (straight Mac- or Windows-based Personal 
File Sharing, more-secure Remote Login, FTP Access, and so on). 
Highlight a service in the Service list, and click the Start button 

to enable the service. 
Next, click the Firewall 
tab, click the Start 
button to lock everything 
down, and then check 
the appropriate boxes 
to enable the specific 
services you turned on.

If you don’t use a router, 
all of the magic happens  
in System Preferences. 

Tapping into your home network from work or the road isn’t always 
as easy as we magazine folks make it out to be.

Dude, What’s My IP?2 Now you need to lay a breadcrumb trail so you can find 
your way in from points unknown. If your ISP provides a 

static IP (one that’s always on and never changes), simply use 
that number in another Mac’s Connect To Server dialog (in the 
Finder, select Go > Connect To Server) to log in. If your account 
provides a dynamic, changing IP, you’ll have to note your 
current IP address and hope you don’t lose the connection. 
Either way, in System Preferences, click Energy Saver, and then 
click the Options tab. Check the Wake For Ethernet Network 
Administrator Access and Restart Automatically After A Power 
Failure boxes. Then, go to System Preferences > Network, select 

Network Status from 
the Show pull-down 
menu, and jot down 
the reported IP 
address. 

You can’t access your 
Mac if it’s shut down. 
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To access a Mac on a home network that uses a router, 
you need to designate that Mac as the DMZ (demilitarized 

zone)—or Default Host in AirPort Extreme parlance. Launch the 
AirPort Admin Utility (/Applications/Utilities), log into your Base 
Station, and click the AirPort tab. Click the Base Station Options 
button, check the box labeled Enable Default Host At, keep 
the default setting (10.0.1.253), and click OK. If you’re using a 
dynamic-IP account, click the Internet tab, check the Always Stay 
Connected box, and click Update. After the Base Station refreshes, 
note the IP address reported in the Configure TCP/IP section—that’s 

the server address you’ll 
use to connect from afar.

Once you enable a default 
host or DMZ, the router’s 
firewall will let you right in.

DMZ for You and Me3 Now set your Mac’s IP address to match the designated 
default host address, so that when you enter your 

Base Station’s or router’s IP address (from step 3), the router 
automatically forwards the traffic to the default host Mac. Open 
System Preferences > Network, and select Built-In Ethernet 
from the Show menu. Select Manually from the Configure IPv4 
menu. Enter 10.0.1.253 in the IP Address field, leave the Subnet 
Mask at 255.255.255.0, and enter the router’s IP address on 

your local network. AirPort Extreme 
uses 10.0.1.1; Belkin and D-Link routers 
use 192.167.0.1; consult your router’s 
manual for help. Finally, enter a DNS 
Server or two—get some from your ISP.

Router Runaround4

The router expects a specific IP address, 
which you can force on any connected Mac.

Mac OS 10.3 or later

Internet connection (cable or DSL recommended)

AirPort Extreme Base Station or similar router (optional)

WHAT YOU NEED

D
on’t you just hate it when know-it-all magazine writers 
drop bombs like, “Just log into your home Mac from 
work”? Depending on your network setup, remote 
access can be a pain to set up—and a security risk if 

done incorrectly. Here’s how to get into your Mac from afar. 

Tap Into Your Home Network Remotely
by Niko Coucouvanis
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Dig Into Quartz Composer
by Erick Tejkowski

Mac OS 10.4 or later ($129, www.apple.com) 

Quartz Composer (free with Mac OS 10.4, 
installed with Developer Tools, http://
developer.apple.com)

QuickTime 7 (free, www.apple.com/quicktime)

A
pple’s Quartz graphics technology is the talk of the 
town—but what the heck is it, exactly? Follow us into 
the belly of Quartz Composer, a free tool from Apple 
that helps developers create Mac OS X’s eye-popping 

screen savers, QuickTime multimedia content, and other visual 
treats. Need a groovy title background for your next iMovie 
documentary? Some eye candy for your video-capable iPod? 

Perhaps you desire a new screensaver that displays information 
from your favorite Web site? Quartz Composer has you covered 
for all of this and more. We’ll show you how to get started with 
Quartz Composer by customizing an animated 3D screen saver 
and preparing a movie clip for an iMovie project. As you might 
guess, we’re just scratching Quartz Composer’s surface here, 
but the principles will take you far into this cool tool.

1 Get the Goods
Quartz Composer is part of Apple’s Xcode Tools 
developers’ toolkit; if you haven’t installed Xcode 

Tools, you can fi nd it in the Xcode Tools folder on your Mac 
OS 10.4 (Tiger) installation disc. You can also download it 
after registering for a free Apple Developer Connection online 
membership account at http://developer.apple.com. After 
installing the package, fi nd Quartz Composer in /Developer/
Applications/Graphics Tools, and double-click to launch it. If you 
don’t see the New Composition From Template Assistant fi rst, 
select File > New From Template to open it. Click Mac OS X RSS 
Screen Saver in the template list, and click Next. Enter a name for 
your composition, and specify whether you’d like to install the 

Good artists 
create, but great 
artists steal—er, 
use templates.

fi nal screen saver for your own exclusive use or for all of the user 
accounts on your Mac. Click Finish.

PATCH AND CLIP 
LIBRARIES: Find 
the building 
blocks here—
mathematical 
operations, MIDI 
processing, and 
access to all of 
OS X’s righteous 
Core Image 
fi lters.

COMPOSITION EDITOR: Drag 
Patches or Clips into this window; 
then draw lines of association to 
wire patches together.

PATCH AND CLIP 

MACRO-PATCH EDITOR: Click here to 
create a sub-composition, which you 
can build into the main composition.

HIERARCHY BROWSER: Provides one-
click navigation to different parts of 
the composition.

EDIT PARENT: Click here to exit 
the Macro editor and return to 
editing its parent.

INSPECTOR: Provides easy 
access to patches’ Information, 
Settings, and Input Parameters.

VIEWER: 
Previews your 
composition 
in a separate 
window.

WHAT YOU NEED
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Now that you’ve created the perfect rolling-gradient 
animation, it’d be a shame to relegate it to mere 

screen-saver duty. To free your creation, select File > Export To 
QuickTime, enter a name, select where you want the fi le saved, 
and click Save. In the resulting Export window, you can adjust 
the clip’s duration and dimensions. For good ol’ American NTSC 
DV format, enter 720 by 480. Finally, click Export to save the 
movie. Now you’ve got a MOV fi le ready to import into any iMovie 
project. Note that if you simply save a Composer project rather 

 Erick Tejkowski remembers a day when we needed screen savers 
to protect our screens, not to make us look cool.

5 Crank the Color

It’s Not Just for Screen Savers

2 Enter the Editor
Composer’s Editor includes a library of all the elements 
you can use in your compositions. Patches are the basic 

building blocks of a composition; clips are pre-assembled 
mini-compositions (such as a glowing Apple logo or a spinning 
3D cube). Patches do everything from displaying graphics to 
computing insanely complex vector algorithms. Patches can also 
apply any of OS X’s celebrated Core Image fi lters. All patches 
have ports on them, which appear as small, labeled circles. You 
connect patches to one another by dragging from an output port 
on the right side of one patch to the input port on the left side of 

A simple patch: Notice the 
input and output ports and 
their groovy connectors.

another patch. If the two patches aren’t connectable, Composer 
won’t draw the connector for you. Since you’re using a template, 
some patches are already in place; select Editor > Zoom Out to see 
the entire patchwork that creates the RSS-feed screen saver.

3 Pinch the Patch
In the sample composition that we’re repurposing, 
Apple has already done the hard work of wiring together 

a composition that gathers RSS data from Apple’s Web site 
and scrolls the text up the screen on a swirling animated 
background. To change the content, simply fi nd the RSS 
Feed patch (it’s on the far-left side of the Editor window), and 
double-click the port circle next to the URL; this spawns an 
editable fi eld where you can enter a different RSS feed to fuel 
your screen saver. Enter http://www.macaddict.com/index.xml 
to keep tabs on MacAddict’s home page, and press Return to 
accept the edit. Verify the changes in the Viewer window, and 
if you like what you see, select File > Save (Command-S) to save 
the screen saver and automatically add it to the list of choices in 
System Preferences > Desktop & Screen Saver. Rather than recreate this bear, we’ll simply tweak one of the patches.

4 No News Is Good News
Quartz Composer isn’t just for screen savers. Now it’s 
time to modify this project and save it as a clip that you 

can use in other Composer compositions, such as an iMovie 
documentary chronicling the electrifying saga of the three-toed 
sloth. To remove the dynamic RSS feed, select its patch and 
press Delete. Poof! It’s gone. 

Delete this patch, and 
the words will instantly 
disappear from the Viewer 
window to the right.

Some patches provide an incredible amount of 
customization options, including nested Macros, 

which are well beyond the scope of this article (but feel free to 
experiment on your own). Start with an easy patch to change 
your composition’s color: First, click the Hierarchy Browser 
button, and select Background in the resulting column. The main 
editing window will refresh itself to show the patches that control 
the background. Select the Gradient patch, and click the Editor’s 
Inspector icon to open the Inspector window; select Input 
Parameters from the top pull-down menu. Now you can enable 
or disable the gradient and easily select Start, Middle, and End 

When you select the 
Gradient patch, the 
Inspector provides 
handy adjusters, 
and the Viewer 
updates in real time.

Quartz Composer exports to 
QuickTime. Next stop: iMovie!

colors while the Viewer window updates to match. You can use 
similar tactics on any patch in any composition.

6

than exporting to QuickTime, the resulting QTZ fi le is completely 
QuickTime friendly—but you’ll have to re-export it out of 
QuickTime Pro ($29.99, www.apple.com) for iMovie use.



The Quick(Time) Way1 Simply encoding a video for iPod playback is surprisingly 
easy; the hardest part is coughing up $29 for QuickTime 

Pro, which contains a handy method to export movies to your iPod 
right in its menu—just open your clip in QuickTime Pro, and select 
File > Export > Movie To iPod (320 x 240). When it’s done, drag your 
finished M4V file into iTunes. Find your clip in iTunes’ Videos list, 
and click on it to check it out in the video-preview window. If all’s 

well, drag the file from 
the Videos list onto your 
iPod’s icon in the Source 
list (remember that last 
part—you’ll need it in the 
following steps to get the 
files onto your iPod).

It doesn’t get much  
easier than this.  

Dissatisfied with the official iPod video fare? Make your own.

Move It in iMovie HD2 If you don’t have QT Pro, you can still get your movies 
onto your ’Pod if you have QT 7.0.3 (non-Pro) and iMovie 

HD (part of iLife ’05). Launch iMovie HD and click Create A New 
Project. Leave the Video Format at its default. Save the empty 
project, and import your movie file by dragging it into the iMovie 
HD window. Once your clip appears in iMovie’s clip drawer, click 
the Timeline button to open the Timeline Viewer, and drag your 
clip from the clip drawer to the Timeline. Select File > Share. 
In the resulting dialog, click the QuickTime button and select 

Expert Settings from the 
pull-down menu. Finally, 
click Share, and select 
Movie To iPod from the 
resulting Export menu.

If you have iLife ’05, you  
don’t need QuickTime Pro.

Do Your DVDs3 This next step is for personal use only. Don’t illegally 
share your commercial DVDs—remember, Santa’s 

making a list and checking it twice. Insert a DVD into your Mac’s 
DVD drive, wait for it to mount on the desktop, and then fire up 
Handbrake (free, http://handbrake.m0k.org). Your disc should 
appear in Handbrake’s Detected Volume menu. Follow the 
onscreen instructions with the following guidelines: Set the File 
Format to MP4 
File, and select 

Codecs > MPEG-4 Video / 
AAC Audio from the Codecs 
menu; in the Video section, 
tweak the framerate if you 
like, leave the encoder at 
its default (FFmpeg), click 
the Average Bitrate button, 
and enter a value lower 
than 768 (any higher won’t 
play on an iPod; 500 Kbps 
gave us a good-looking video). Finally, click the Picture Settings 
button and change the movie’s dimensions to 320 by 240—note 
that you can’t directly edit the fields, so you have to use the 
up and down arrows. The above guidelines are the baseline 
requirements, but you’re free to twiddle any other settings.

Fair’s fair, and 
in our book, 

making a backup 
is a right, not a 

privilege.

Don’t forget to tweak the Picture 
Settings.
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Fifth-generation (video-capable) iPod

Video files or DVDs 

QuickTime Pro 7.0.3 ($29, www.apple.com) or iMovie HD 
($79.95 as part of iLife ’05) and QuickTime 7.0.3 (free)

Handbrake 0.7.0 (free, http://handbrake.m0k.org)

WHAT YOU NEED

T
he video-capable iPod is finally here, but content 
options are sorely limited—a handful of TV shows, 
music videos, and movie trailers. Wouldn’t it be sweet 
if you could create your own content out of repurposed 

video clips (TiVo, anyone?) and backups of your commercial 
DVDs? Read on.

Get Videos onto Your iPod
by Niko Coucouvanis
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20% A %@#&ing 
scratch-resistant 
screen

31% Bluetooth 
or other wireless 
technology

FICTIONARY
I was reading Rik’s editorial 
in the Oct/05 issue, and 
in the second paragraph, 
he uses the phrase “one 
skanky shamteuse after 
another.” What the heck 
does shamteuse mean? I 
can’t fi nd a defi nition, and 
Google shows only two 
hits—both imply that it’s 
a made-up word.—Steve

Rest assured that we 
editorialonians at MacAddict
don’t tolerate neologistical 
inventifi cations, especially 
those regarding such 
weightilicious topics as 
sham vocalisticators.—Max

WEIRD SCIENCE
I just have to say that Niko 
Coucouvanis is a genius. 
Through the years, his how-
tos have taught me how 
to overclock my Mac mini, 
extend my AirPort range 
with a Pringles can, and 
power my iPod shuffl e with 
a 9V battery. He embodies 

the spirit of the Mac-user: 
hardcore, insane, and willing 
to ruin expensive hardware in 
the name of science.
—Brendan Fox

BATTERY DILATION
I’ve always loved how 
optimistic my PowerBook 
G4 is just after it’s woken 
up from a good, long sleep 
(see screenshot below). Of 
course, reality kicks in after 
just a few seconds—but still, 
I feel special for just a little 
while!—Misha
Are you sure that you and 
your iBook weren’t moving 
at or near the speed of light? 
That can really mess with 
your sense of time.—Max

IS YOUR MAC 
RUNNING?
It seemed of late that I was 
seeing the Technicolor wheel 
spinning on my G5 more than 
I was seeing my husband. 
Then I followed many of the 
steps outlined in “Clean Up 
Your Mac” (Oct/05, p16), 
and I cannot get over the 
difference! While I miss 
my desktop picture, my 
applications now leave skid 

marks when starting up. I 
still don’t see my husband 
that much—but I’m working 
much better!—Leslie Ocko
Glad we could help, and if 
you’re looking for a good 
divorce attorney, call 555-
749-3890. Ask for Bubba.
—Max

iBLINDNESS
Putting an iSight camera 
in the iMac might sound 
like a good idea, but lots 
of workplaces (such as 

military contractors) don’t 
allow you to have cameras. 
I was looking into getting a 
few new iMacs in my place 
of business, but I wasn’t 
allowed—my building has 
a “No Cameras Allowed” 
policy for security reasons.
—Richard Kirkham
How about taking a tip from 
Odysseus’s playbook—the 
part where he meets the 
Cyclops?—Max

MOVING VIOLATION
I don’t think you should have 
said the AirClick remote is 
“good for biking” (“’Pod 
People,” Dec/05, p30). In 
most states, it’s illegal to 
wear headphones while 
biking. Here in Illinois, your 
license could get suspended.
—Charles

STOP WHISPERING
After reading “Make Your 
Mac a GarageBand Singer” 
(Nov/05, p64), I felt I should 
point out another use of the 
Mac voice as a singer. On 

’BOOK SIGNING
Here’s how to create your very own iBook G4 Woz Limited 
Edition, just like those charming old Woz Limited Edition 
IIGS systems. Check out www.fl oodgap.com/retrotech/
mac/wozibook.—Cameron Kaiser
Hmm, that beats the “Etch Your iPod nano’s Screen with 
the Signature of the Guy Who Designed the Mighty Mouse” 
how-to we had planned for this month.—Max

The theory of relativity can 
extend the life of your battery.

Although Mr. Kaiser Wozifi ed his ’Book, you can just as easily 
create a Limited Edition iBook featuring Steve Jobs, Burrell 
Smith, or any of your favorite Apple characters.

Left: chanteuse. Right: 
shamteuse.

WHAT DO YOU HOPE TO SEE IN THE 
NEXT-GENERATION iPOD?

tell us how you really feel

Survey 
Says
Here are the results 
of our October 2005 
survey. Check out 
www.macaddict.com 
each month for a 
new online poll.

1,075 respondents

16% Improved 
video support

11% A decent 
phone

14% Bigger 
screen

8% Larger 
storage capacity
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CONTESTANT INFORMATION  
Full Name:

Address:

City:                                                               State:

Zip:

Email or telephone:    

Congratulations 
to Robert Tomsick, 

who won an Epson Stylus Photo 
R1800 ($549, www.epson.com) 
with a droll Unix pun that tickled 
our geeky editors. (If the joke eludes 
you, think Macaulay Culkin.) Better 
luck next time to the 65 readers who 
riffed on Apple’s move to Intel chips. 

Winner!

vv    
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Win a Wacom Graphire4!
If you’ve never used a graphics tablet, you don’t know what 
you’re missing—and if you have, you know that Wacom tablets 
work great with Macs. Just write the best caption to the image 
below, and you can start tabletizing with not only a 6-by-8-inch 
Wacom Graphire4 tablet, mouse, and pen ($199.95, www
.wacom.com), but also a software bundle that includes Adobe 
Photoshop Elements 3, Corel Painter Essentials 2, nik Color Efex 
Pro 2 GE, and more.  Only one entry per contestant.

79

Radiohead’s 1997 album 
OK Computer, frontman 
Thom Yorke used his Mac’s 
default voice to produce the 
vocals on the track “Fitter 
Happier.” Of course, this 
had to be recorded onto a 
studio tape, as GarageBand 
was still fi ve years away.
—Jesse Staples
Indeed, the voice used 
in Radiohead’s “Fitter 
Happier” sounds very much 
like Mac OS X’s Fred, though 
when we tried typing the 
lyrics and having Fred read 
them, we noticed subtle 
infl ection differences. Back 
in 1997, Mr. Yorke would 
have been using OS 8 or 
a late-model System 7, so 
we suspect Fred may have 
evolved since then.—Max

REGARDING 
YOUR ACCOUNT
We are pleased to inform 
you that we have located 
a few girls within a couple 
miles of your location 
that are willing to meet 
with you. Some wish to 
meet discreetly ;-). Please 
be advised that this is 
not your typical dating 
service; privacy is of the 
utmost concern, and your 
satisfaction and discretion 
is top priority.—Jessica
Wholesale Prescription 
Medications! No Prior 
Prescription Required! OUR 
DOCTORS WILL WRITE YOU 
A PRESCRIPTION FOR FREE! 
(And after meeting with 
Jessica’s friends, you may 
need it.)—Max

THAT MAGIC SHINE
I fi nally found something that 
really cleans my iBook: a Mr. 
Clean Magic Eraser. I am a 
stay-at-home dad with three 
kids (ages six, three, and 
one). I bought it to remove 
the crayon caveman drawings 
on the wall; from there I tried 
it on everything, then it hit 
me—my iBook—and bingo! 
It totally takes away palm 
prints and all.—Chris Dufrene

ARITHMILARIOUS
Your pi humor (Shut Down, 
Dec/05, p80) was really 
great to a retired 74-year-old 
physicist who had forgotten 
Count Avogadro’s given name. 
I remember his number as 
6.023 x 1023, but 6.02 x 1023 is 
close enough.—Charles Crume
Alas, we only had enough 
time to search through the 
fi rst 8,152,090 digits of pi to 
fi nd that 6021023 sequence. 
And wouldn’t you know it, 
60231023 showed up at 
position 46,629,088—but 
by the time we realized it, 
our deadline had passed. 
Ho-ho, ain’t that always the 
way?—Max

SIGHTS AND SOUNDS
I couldn’t agree more with 
Rik’s November 2005 editorial 
(“Take Time to Whistle,” p10). 
While I listen to my iPod when 
running, it’s left behind all 
other times. Has anyone ever 
heard the sound of silence? 
It’s a beautiful thing.
—Basil O. Gordon

Dufrene-approved: $7.49 at 
www.amazon.com.

Fred? Is that you?

~/ Alone

Send email entries to: contest@macaddict.com with the subject: Wacom Contest 
(Don’t forget to include your address information!)
Send snail-mail entries to: Wacom Contest, MacAddict magazine, 
4000 Shoreline Court, Suite 400, South San Francisco, CA 94080.
Deadline for entry: February 28, 2006.
Contest results will appear in our June/06 issue.

Contest Rules The judges will be MacAddict editors and will base their decision on 33 percent humor, 33 percent 
originality, and 33 percent creativity. All entries must be received no later than February 28, 2006, with the winner 
announced around June 2006. By entering this contest, you agree that Future US, Inc. may use your name, likeness, 
and Web site for promotional purposes without further payment. All prizes will be awarded, and no minimum number 
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Write a caption for this picture.

WIN!
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If you’re planning on braving this year’s Mac 
Expo in San Francisco’s sprawling Moscone 

Center, be sure to stop by the MacAddict 
booth to pick up your Mac Expo Survival 
Kit—but hurry, supplies are limited! (And by 
“limited,” we really mean “nonexistent.”)

Mac Expo 
Survival Kit

Street Sheet
Bought a convention-center 
hot dog, and now you’re 
strapped for cash? Hawk a few 
copies of San Francisco’s fi nest 

vagabond-distributed news 
rag, and you’ll be back 
on your feet in no time.

BS Detector
Complete with mute 
button—trust us, 
you’ll need it.

Chintzy Souvenir
Prove how much you love 
the City by the Bay by 
purchasing a tchotchke an 
actual resident wouldn’t 
be caught dead with.

Pain Reliever
Because you can’t spell Apple’s 
convention without constant pain.

Lusty Lady 
Tokens
After a long day 
of product demos, 
kick back with the 
lovely ladies of the 
only unionized, 
worker-owned 
strip joint in the 
nation—soooo 
San Francisco!

Dr. Scholl’s Gellin’ 
Massaging Gel Pads
Because the Moscone 
Center contains over 
700,000 square feet of 
exhibit space.

Spare Change
Make your way through the 
homeless throng gathered 
outside the convention-
center doors with these 
shiny objects.

Kee-Note™ 
Pass (One)
Your falsifi ed 
ticket to Steve’s 
Big Important 
Speech—just 
don’t let the 
security guards 
look too closely.

Numbing Juice
When you’ve seen 
one math-tutoring 
teddy bear too 
many, remember 
that good things 
come in small 
bottles.
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